You can find the most up-to-date technical documentation on the VMware Web site at:
http://www.vmware.com/support/
The VMware Web site also provides the latest product updates.
If you have comments about this documentation, submit your feedback to:
docfeedback@vmware.com
Contents

About This Book  5

Updated Information  7

1 Introduction to VMware vCenter Converter Standalone  9
   Migration with Converter Standalone  9
   Converter Standalone Components  10
   Cloning and System Configuration of Physical Machines  10
   Types of Data Cloning Operations  15
   Using Converter Standalone with Virtual Machine Sources and System Images  18
   System Settings Affected by Conversion  18
   Changes to Virtual Hardware  19

2 System Requirements  21
   Supported Operating Systems  21
   Installation Space Requirements  22
   Screen Resolution Requirements  23
   Supported Source Types  23
   Supported Destination Types  25
   Restoring VCB Images in Converter Standalone  26
   Configuring Permissions for vCenter Users  27
   Support for IPv6 in Converter Standalone  28
   TCP/IP and UDP Port Requirements for Conversion  28
   Requirements for Remote Hot Cloning of Windows Operating Systems  30

3 Installing and Uninstalling Converter Standalone  33
   Perform a Local Installation on Windows  33
   Perform a Client-Server Installation in Windows  34
   Perform a Command-Line Installation in Windows  36
   Command-Line Options for Windows Installation  36
   Modify Converter Standalone in Windows  37
   Repair Converter Standalone in Windows  38
   Uninstall Converter Standalone in Windows  39
   Connect to a Remote Converter Standalone Server  39

4 Convert a Physical or Virtual Machine  41
   Start the Wizard for a Conversion  42
   Select a Source Machine to Convert  42
   Select a Destination for the New Virtual Machine  48
   Configure the Hardware of the Destination Virtual Machine  51
   Configure the Software on the Destination Virtual Machine  63
Configure the Conversion Job 69
Review the Summary and Submit the Conversion Job 74

5 Configure Virtual Machines 75
  Save Sysprep Files 75
  Start the Configuration Wizard 76
  Select a Source Machine to Configure 76
  Select the Options to Configure 79
  Review and Submit the Configuration Job 83

6 Manage Conversion and Configuration Jobs and Tasks 85
  Manage Jobs in the Job List 85
  Manage Tasks in the Task List 89
  Verify Jobs and Tasks Progress and the Log Files 91

Index 95
About This Book

The *VMware vCenter Converter Standalone User’s Guide* provides information about installing and using VMware® vCenter Converter Standalone 5.0.

**Intended Audience**

This book is intended for users who want to perform the following tasks:

- Install, upgrade, or use Converter Standalone
- Nonintrusively copy and transform physical machines into VMware virtual machines that VMware vCenter manages

The material in this book is written for information systems engineers, software developers, QA engineers, trainers, salespeople who run demonstrations, and anyone who wants to create virtual machines.

**VMware Technical Publications Glossary**

VMware Technical Publications provides a glossary of terms that might be unfamiliar to you. For definitions of terms as they are used in VMware technical documentation, go to [http://www.vmware.com/support/pubs](http://www.vmware.com/support/pubs).

**Document Feedback**

VMware welcomes your suggestions for improving our documentation. If you have comments, send your feedback to docfeedback@vmware.com.
Technical Support and Education Resources

The following technical support resources are available to you. To access the current version of this book and other books, go to http://www.vmware.com/support/pubs.

**Online and Telephone Support**

To use online support to submit technical support requests, view your product and contract information, and register your products, go to http://www.vmware.com/support.

Customers with appropriate support contracts should use telephone support for the fastest response on priority 1 issues. Go to http://www.vmware.com/support/phone_support.html.

**Support Offerings**

To find out how VMware support offerings can help meet your business needs, go to http://www.vmware.com/support/services.

**VMware Professional Services**

VMware Education Services courses offer extensive hands-on labs, case study examples, and course materials designed to be used as on-the-job reference tools. Courses are available onsite, in the classroom, and live online. For onsite pilot programs and implementation best practices, VMware Consulting Services provides offerings to help you assess, plan, build, and manage your virtual environment. To access information about education classes, certification programs, and consulting services, go to http://www.vmware.com/services.
Updated Information

This VMware vCenter Converter Standalone User’s Guide is updated with each release of the product or when necessary.

This table provides the update history of the VMware vCenter Converter Standalone User’s Guide.

<table>
<thead>
<tr>
<th>Revision</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>EN-000408-01</td>
<td>In “Configuring Permissions for vCenter Users,” on page 27, updated the minimum user permissions required for converting virtual machines to vCenter Server machines.</td>
</tr>
<tr>
<td>EN-000408-00</td>
<td>Initial release.</td>
</tr>
</tbody>
</table>
VMware® vCenter Converter Standalone is a scalable solution to convert virtual and physical machines to VMware virtual machines. You can also configure existing virtual machines in your vCenter Server environment.

Converter Standalone eases the exchange of virtual machines among the following products.

- VMware hosted products can be both conversion sources and conversion destinations.
  - VMware Workstation
  - VMware Fusion™
  - VMware Server
  - VMware Player

- Virtual machines running on an ESX instance that vCenter Server manages can be both conversion sources and conversion destinations.

- Virtual machines running on unmanaged ESX hosts can be both conversion sources and conversion destinations.

You can also use VMware Consolidated Backup (VCB) images to create VMware virtual machines.

This chapter includes the following topics:

- “Migration with Converter Standalone,” on page 9
- “Converter Standalone Components,” on page 10
- “Cloning and System Configuration of Physical Machines,” on page 10
- “Types of Data Cloning Operations,” on page 15
- “Using Converter Standalone with Virtual Machine Sources and System Images,” on page 18
- “System Settings Affected by Conversion,” on page 18
- “Changes to Virtual Hardware,” on page 19

Migration with Converter Standalone

Migration with Converter Standalone involves converting physical machines, virtual machines, and system images for use in VMware hosted and managed products.

You can convert virtual machines that vCenter Server manages for use in other VMware products. You can use Converter Standalone to perform a number of conversion tasks.

- Import running remote physical and virtual machines as virtual machines to standalone ESX/ESXi or to ESX/ESXi hosts that vCenter Server manages.
- Import virtual machines hosted by VMware Workstation or Microsoft Hyper-V Server to ESX/ESXi hosts that vCenter Server manages.
- Import third-party backup or disk images to ESX/ESXi hosts that vCenter Server manages.
- Export virtual machines managed by vCenter Server hosts to other VMware virtual machine formats.
- Create VMware virtual machines from VCB images.
- Configure virtual machines managed by vCenter Server so that they are bootable, and install VMware Tools or customize their guest operating systems.
- Customize the guest operating systems of virtual machines in the vCenter Server inventory (for example, change the host name or network settings).
- Reduce the time needed to set up new virtual machine environments.
- Migrate legacy servers to new hardware without reinstalling operating systems or application software.
- Perform migrations across heterogeneous hardware.
- Readjust volume sizes and place volumes on separate virtual disks.

**Converter Standalone Components**

The Converter Standalone application consists of Converter Standalone server, Converter Standalone worker, Converter Standalone client, and Converter Standalone agent.

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Converter Standalone server</td>
<td>Enables and performs the import and export of virtual machines. The Converter Standalone server comprises two services, Converter Standalone server and Converter Standalone worker. The Converter Standalone worker service is always installed with the Converter Standalone server service.</td>
</tr>
<tr>
<td>Converter Standalone agent</td>
<td>The Converter Standalone server installs the agent on Windows physical machines to import them as virtual machines. You can choose to remove the Converter Standalone agent from the physical machine automatically or manually after the import is complete.</td>
</tr>
<tr>
<td>Converter Standalone client</td>
<td>The Converter Standalone server works with the Converter Standalone client. The client component consists of the Converter Standalone user interface, which provides access to the Conversion and the Configuration wizards, and allows you to manage the conversion and the configuration tasks.</td>
</tr>
</tbody>
</table>

**VMware vCenter Converter Boot CD**

The VMware vCenter Converter Boot CD is a separate component that you can use to perform cold cloning on a physical machine. Converter Standalone 4.3 and later versions do not provide a Boot CD, but you can use previous versions of the Boot CD to perform cold cloning. See “Prepare for Cold Cloning,” on page 15.

**Cloning and System Configuration of Physical Machines**

When you convert a physical machine, Converter Standalone uses cloning and system reconfiguration steps to create and configure the destination virtual machine so that it works successfully in the vCenter Server environment. Because the migration process is nondestructive to the source, you can continue to use the original source machine after the conversion completes.

Cloning is the process of copying the source physical disks or volumes for the destination virtual machine. Cloning involves copying the data on the source machine’s hard disk and transferring that data to a destination virtual disk. The destination virtual disk might have a different geometry, size, file layout, and other characteristics, so the destination virtual disk might not be an exact copy of the source disk.

System reconfiguration adjusts the migrated operating system to enable it to function on virtual hardware.
If you plan to run an imported virtual machine on the same network as the source physical machine, you must modify the network name and IP address on one of the machines, so that the physical and virtual machines can coexist. Besides, you must make sure that the Windows source machine and the destination virtual machine have different computer names.

**Note** You cannot move original equipment manufacturer (OEM) licenses between physical machines. The license is attached to the server when you purchase it from the OEM and cannot be reassigned. You can only reassign retail and volume licenses to new physical servers. If you migrate an OEM Windows image, you must have a Windows Server Enterprise or Datacenter Edition license to run multiple virtual machines.

**Hot and Cold Cloning of Physical Machines**

Although Converter Standalone 4.3 and later versions support only hot cloning, you can still perform cold cloning by using the VMware Converter 4.1.x Boot CD. Depending on your virtual environment, you can choose to use hot or cold cloning.

Hot cloning, also called live cloning or online cloning, requires converting the source machine while it is running its operating system. Hot cloning lets you clone machines without shutting them down.

Because processes continue to run on the source machine during conversion, the resulting virtual machine is not an exact copy of the source machine.

When converting Windows sources, you can set Converter Standalone to synchronize the destination virtual machine with the source machine after hot cloning. Synchronization is performed by transferring from the source to the destination the blocks that were changed during the initial cloning period. To avoid loss of data on the destination virtual machine, Converter Standalone can shut down certain Windows services before the synchronization. Based on your settings, Converter Standalone shuts down the selected Windows services so that no critical changes occur on the source machine while destination is being synchronized.

Converter Standalone can shut down the source machine and power on the destination machine when the conversion process is complete. When combined with synchronization, this action allows seamless migration of a physical machine source to a virtual machine destination. The destination machine takes over the source machine operations with the least possible downtime.

**Note** When you hot clone dual-boot systems, you can clone only the default operating system to which the boot.ini file points. To clone the nondefault operating system, change the boot.ini file to point to the other operating system and reboot. After the other operating system is booted, you can hot clone it. If your second operating system is Linux, you can boot it and clone it using the standard procedure for cloning Linux physical machine sources.

Cold cloning, also called offline cloning, entails cloning the source machine when it is not running its operating system. When you cold clone a machine, you reboot the source machine using a CD that has its own operating system and the vCenter Converter application on it. Cold cloning allows you to create the most consistent copy of the source machine because nothing changes on the source machine during the conversion. Cold cloning leaves no footprint on the source machine, but requires direct access to the source machine that is being cloned.

When you cold clone a Linux source, the resulting virtual machine is an exact replica of the source machine and you cannot configure the destination virtual machine. You must configure the destination virtual machine after the cloning is complete.

Table 1-1 compares the hot and cold cloning modes.
Table 1-1. Hot and Cold Cloning Comparison

<table>
<thead>
<tr>
<th>Comparison Criteria</th>
<th>Hot Cloning with Converter Standalone 4.3 and 5.x</th>
<th>Cold Cloning with Converter Enterprise 4.1.x</th>
</tr>
</thead>
<tbody>
<tr>
<td>Licensing</td>
<td>No license required with VMware vCenter Converter Standalone 4.3 and 5.x.</td>
<td>License file required for Enterprise features of VMware Converter Enterprise.</td>
</tr>
<tr>
<td>Required installation</td>
<td>Full Converter Standalone installation is required. As part of the cloning process, Converter Standalone agent is installed on the source machine remotely.</td>
<td>No installation is required. All components required for the conversion are on the CD.</td>
</tr>
<tr>
<td>Supported sources</td>
<td>Local and remote powered-on physical or virtual machines.</td>
<td>Local powered-off physical or virtual machines.</td>
</tr>
</tbody>
</table>
| Advantages          | ■ Does not require direct access to the source machine.  
                      ■ Clones the source machine while it is running. | ■ Creates the most consistent copy of the source machine.  
                      ■ Leaves no footprint on the source machine. |
| Disadvantages       | ■ Applications that constantly modify files need to be VSS aware to allow Converter Standalone to create a consistent snapshot for cloning.  
                      ■ Dynamic source disks are read but not preserved during volume-based conversions. Dynamic disks are converted into basic volumes on the target virtual machine. | ■ Requires that the source machine is powered off.  
                      ■ Requires physical access to the source machine.  
                      ■ Hardware detection and configuration of the Boot CD.  
                      ■ Converter Standalone 4.x features are not supported. |
| Use                 | ■ To clone running source machines without shutting them down.  
                      ■ To clone unique hardware that the Boot CD does not recognize. | ■ To clone a system that Converter Standalone does not support.  
                      ■ To preserve the exact disk layout in the target.  
                      ■ To preserve logical volumes in dynamic disks (Windows) or LVM (Linux). |
| When to not use     | When you do not want anything to be installed on the source system. | ■ When you want Linux P2V with automatic reconfiguration.  
                      ■ When you do not have physical access to the source machine.  
                      ■ When you cannot afford a long downtime of the source system.  
                      ■ To perform synchronization after cloning. |

Remote Hot Cloning of Physical Machine Sources That Are Running Windows

You can use the Conversion wizard to set up conversion tasks and Converter Standalone components perform all of the cloning tasks.

The following workflow is an example of remote hot cloning in which the physical machine being cloned experiences no downtime.

1. Converter Standalone prepares the source machine for the conversion.
   Converter Standalone installs the agent on the source machine and the agent takes a snapshot of the source volumes.
2. **Converter Standalone prepares the virtual machine on the destination machine.**

   Converter Standalone creates a virtual machine on the destination machine and the agent copies volumes from the source machine to the destination machine.

3. **Converter Standalone completes the conversion process.**

   The agent installs the required drivers to allow the operating system to boot in a virtual machine and personalizes the virtual machine (changes the IP information, for example).

4. **Optionally, Converter Standalone uninstalls the agent from the source machine.**

   The virtual machine is ready to run on the destination server.
Remote Hot Cloning of Physical Machine Sources That Are Running Linux

The conversion process of physical machines that are running Linux operating systems differs from that of Windows machines.

In Windows conversions, the Converter Standalone agent is installed on the source machine and the source information is pushed to the destination.

In Linux conversions, no agent is deployed on the source machine. Instead, a helper virtual machine is created and deployed on the destination ESX/ESXi host. The source data is then copied from the source Linux machine to the helper virtual machine. After the conversion is complete, the helper virtual machine shuts down to become the destination virtual machine the next time you power it on.

Converter Standalone supports conversion of Linux sources only to managed destinations.

The following workflow demonstrates the principles of hot cloning physical machine sources that run Linux to managed destinations.

1. Converter Standalone uses SSH to connect to the source machine and retrieves source information. Converter Standalone creates an empty helper virtual machine based on your conversion task settings. The helper virtual machine serves as a container for the new virtual machine during conversion. Converter Standalone deploys the helper virtual machine on the managed destination, an ESX/ESXi host. The helper virtual machine boots from a *.iso file that is located on the Converter Standalone server machine.

2. The helper virtual machine powers on, boots from the Linux image, connects to the source machine through SSH, and starts retrieving the selected data from the source. While you set up the conversion task, you can select which source volumes to be copied to the destination machine.

3. Optionally, after data is copied, the destination virtual machine is reconfigured to allow the operating system to boot in a virtual machine.
Converter Standalone shuts down the helper virtual machine. The conversion process is complete. You can configure Converter Standalone to power on the newly created virtual machine after the conversion is complete.

Prepare for Cold Cloning

Because Converter Standalone 4.3 and later do not support cold cloning, you must use the Boot CD of an earlier vCenter Converter edition. The features supported on the Boot CD depend on the product version you choose. When you cold clone a machine, you reboot the source machine from a CD that has its own operating system and also includes the vCenter Converter application. You can find a detailed description of the cold cloning process in the documentation of the Boot CD you decide to use.

VMware vCenter Converter 4.1.x is not a free software product.

Procedure

1. To obtain a Boot CD, go to the VMware Download Web site and download the vCenter Converter 4.1.x installation package.
2. Extract the Boot CD .iso file from the installation package.
3. Write the Boot CD .iso file on a CD.

What to do next

Follow the onscreen instructions to proceed with cold cloning.

Types of Data Cloning Operations

Converter Standalone supports disk-based cloning, volume-based cloning, and linked-cloning modes.

**IMPORTANT** Converter Standalone cannot detect any source volumes and file systems that are located on physical disks larger than 2TB.

**Table 1-2. Cloning Modes**

<table>
<thead>
<tr>
<th>Data Copy Types</th>
<th>Application</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Volume based</td>
<td>Copy volumes from the source machine to the destination machine.</td>
<td>Volume-based cloning is relatively slow. File-level cloning is slower than block-level cloning. Dynamic disks are converted into basic volumes on the target virtual machine.</td>
</tr>
<tr>
<td>Disk based</td>
<td>Create copies of the source machines, for all types of basic and dynamic disks.</td>
<td>You cannot select which data to copy. Disk-based cloning is faster than volume-based cloning.</td>
</tr>
<tr>
<td>Linked clone</td>
<td>Use to quickly check compatibility of non-VMware images</td>
<td>For certain third-party sources, the linked clone is corrupted if you power on the source machine after the conversion. Linked cloning is the fastest (but incomplete) cloning mode that Converter Standalone supports.</td>
</tr>
</tbody>
</table>
Volume-Based Cloning

During volume-based cloning, volumes from the source machine are copied to the destination machine. Converter Standalone supports volume-based cloning for hot and cold cloning, and during the import of existing virtual machines.

During volume-based cloning, all volumes in the destination virtual machine are converted to basic volumes, regardless of their type in the corresponding source volume.

Volume-based cloning is performed at the file level or block level, depending on the destination volume size that you select.

**Volume-based cloning at the file level**

Performed when you select a size smaller than the original volume for NTFS volumes or you choose to resize a FAT volume.

Volume-based cloning at the file level is supported only for FAT, FAT32, NTFS, ext2, ext3, ext4, and ReiserFS file systems.

Dynamic source disks are read but not preserved during volume-based conversions. Dynamic disks are converted into basic volumes on the target virtual machine.

**Volume-based cloning at the block level**

Performed when you choose to preserve the size of the source volume or when you specify a larger volume size for NTFS source volumes.

For certain cloning modes, Converter Standalone might not support some types of source volumes. Table 1-3 shows the supported and nonsupported source volume types.

<table>
<thead>
<tr>
<th>Cloning Mode</th>
<th>Supported Source Volumes</th>
<th>Nonsupported Source Volumes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Virtual machine conversion</td>
<td>■ Basic volumes</td>
<td>■ RAID</td>
</tr>
<tr>
<td></td>
<td>■ All types of dynamic volumes</td>
<td>■ GUID partition table (GPT) disks</td>
</tr>
<tr>
<td></td>
<td>■ Master boot record (MBR) disks</td>
<td></td>
</tr>
<tr>
<td>Powered-on machine conversion</td>
<td>■ All types of source volumes that Windows recognizes</td>
<td>■ RAID</td>
</tr>
<tr>
<td></td>
<td>■ Linux ext2, ext3, and ReiserFS</td>
<td>■ GUID partition table (GPT) disks</td>
</tr>
</tbody>
</table>

Disk-Based Cloning

Converter Standalone supports disk-based cloning to import existing virtual machines.

Disk-based cloning transfers all sectors from all disks and preserves all volume metadata. The destination virtual machine receives partitions of the same type, size, and structure, as the partitions of the source virtual machine. All volumes on the source machine’s partitions are copied as they are.

Disk-based cloning supports all types of basic and dynamic disks.

Full and Linked Clones

Clones can be full or linked depending on the amount of data copied from the source to the destination machine.

A full clone is an independent copy of a virtual machine that shares nothing with the parent virtual machine after the cloning operation. Ongoing operation of a full clone is separate from the parent virtual machine.

Because a full clone does not share virtual disks with the parent virtual machine, full clones generally perform better than linked clones. Full clones take longer to create than linked clones. Creating a full clone can take several minutes if the files involved are large.

You can create a full clone by using any disk clone type other than the linked clone type.
A linked clone is a copy of a virtual machine that shares virtual disks with the parent virtual machine in an ongoing manner. A linked clone is a fast way to convert and run a new virtual machine. You can create a linked clone from the current state, or snapshot, of a powered-off virtual machine. This practice conserves disk space and allows multiple virtual machines to use the same software installation.

All files available on the source machine at the moment of the snapshot continue to remain available to the linked clone. Ongoing changes to the virtual disk of the parent do not affect the linked clone, and changes to the disk of the linked clone do not affect the source machine. If you make changes to a source Virtual PC and Virtual Server machines, or to LiveState images, the linked clone is corrupted and you cannot use it anymore.

A linked clone must have access to the source. Without access to the source, you cannot use a linked clone at all.

For more information on how to create a linked clone, see “Create a Linked Clone,” on page 60.

**Destination Disk Types**

Depending on the destination you select, several destination disk types are available.

For detailed information on destination virtual disks types, see Table 1-4.

**Table 1-4. Destination Disk Types**

<table>
<thead>
<tr>
<th>Destination</th>
<th>Available Disk Types</th>
</tr>
</thead>
<tbody>
<tr>
<td>VMware Infrastructure virtual machine</td>
<td><strong>Thick</strong> Copies the entire source disk size to the destination, regardless of its used and free space.</td>
</tr>
<tr>
<td></td>
<td><strong>Thin</strong> For managed destinations that support thin provisioning through GUI, creates an expanding disk on the destination. For example, if the source disk size is 10GB, but only 3GB is used, the created destination disk is 3GB but can expand to 10GB.</td>
</tr>
<tr>
<td>VMware Workstation or other VMware virtual machine</td>
<td><strong>Pre-allocated</strong> Copies the entire source disk size to the destination, regardless of its used and free space.</td>
</tr>
<tr>
<td></td>
<td><strong>Not pre-allocated</strong> Creates an expanding disk on the destination. For example, if the source disk size is 20GB, but only 5GB is used, the created destination disk is 5GB but can expand to 20GB. Take this expansion into account when you calculate the free disk space on the destination datastore.</td>
</tr>
<tr>
<td></td>
<td><strong>2GB Split pre-allocated</strong> Splits the source disk into 2GB sections on the destination.</td>
</tr>
<tr>
<td></td>
<td><strong>2GB Split not pre-allocated</strong> Creates 2GB sections on the destination that include only the real used space on the source disk. As the destination disk grows, new 2GB sections are created to accommodate the new data until the size reaches that of the original source disk.</td>
</tr>
</tbody>
</table>

To support destination virtual disks on FAT file systems, divide the source data into 2GB files.
Using Converter Standalone with Virtual Machine Sources and System Images

With Converter Standalone, you can convert virtual machines and system images, and configure VMware virtual machines.

**Converting virtual machines**

You can convert VMware virtual machines from and to Workstation, VMware Player, VMware ACE, VMware Fusion, ESX, ESXi Embedded, ESXi Installable, and VMware Server. You can also import virtual machines from Microsoft Virtual Server and Virtual PC.

To be able to run an imported VMware virtual machine and its source virtual machine on the same network, you must modify the network name and IP address on one of the virtual machines. Modifying the network name and IP address allows the original and new virtual machines to coexist on the same network.

**Configuring virtual machines**

If the VMware virtual machines have disks that are populated by using a backup of a physical host or by cold cloning, Converter Standalone prepares the image to run on VMware virtual hardware. If you have used a third-party virtualization software to create a virtual machine on an ESX host, you can use Converter Standalone to reconfigure it. You can also reconfigure any operating system installed on a multiboot machine if you have imported the virtual machine to an ESX host. Before you reconfigure a multiboot machine, you must change the `boot.ini` file.

**System Settings Affected by Conversion**

A VMware virtual machine that Converter Standalone creates contains a copy of the disk state of the source physical machine, virtual machine, or system image. Some hardware-dependent drivers and sometimes the mapped drive letters might not be preserved.

The following source computer settings remain unchanged:

- Operating system configuration (computer name, security ID, user accounts, profiles, preferences, and so on)
- Applications and data files
- Volume serial number for each disk partition

Because the target and the source virtual machines or system images have the same identities (name, SID, and so on), running them on the same network might result in conflicts. To redeploy the source virtual machine or system image, make sure that you do not run the source and target images or virtual machines on the same network at the same time.

For example, if you use Converter Standalone to test whether you can run a Virtual PC virtual machine as a VMware virtual machine without first decommissioning the original Virtual PC machine, you must first resolve the duplicate ID problem. You can resolve this problem by customizing the virtual machines in the Conversion or the Configuration wizard.
Changes to Virtual Hardware

After conversion, most applications function correctly on the VMware virtual machine because their configuration and data files have the same location as on the source virtual machine. However, applications might not work if they depend on specific characteristics of the underlying hardware, such as the serial number or the device manufacturer.

Table 1-5 contains hardware changes that might occur after virtual machine migration.

Table 1-5. Hardware Changes After Virtual Machine Migration

<table>
<thead>
<tr>
<th>Hardware</th>
<th>Behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU model and serial numbers</td>
<td>Might change after migration if they are activated. They correspond to the physical computer hosting the VMware virtual machine.</td>
</tr>
<tr>
<td>Ethernet adapters</td>
<td>Might change (AMD PCNet or VMXnet) and have a different MAC address. The IP address of each interface must be individually reconfigured.</td>
</tr>
<tr>
<td>Graphics cards</td>
<td>Might change after migration (VMware SVGA card).</td>
</tr>
<tr>
<td>Disks and partitions</td>
<td>The number of disks and partitions might change if you rearrange volumes during the cloning process. Each disk device might have a different model and different manufacturer strings.</td>
</tr>
<tr>
<td>Primary disk controllers</td>
<td>Might differ from the source machine.</td>
</tr>
</tbody>
</table>

Applications might not work if they depend on devices that are not available within a virtual machine.
You must consider the compatibilities and the interoperabilities among the systems on which and with which
the Converter Standalone components work.

This chapter includes the following topics:

- “Supported Operating Systems,” on page 21
- “Installation Space Requirements,” on page 22
- “Screen Resolution Requirements,” on page 23
- “Supported Source Types,” on page 23
- “Supported Destination Types,” on page 25
- “Restoring VCB Images in Converter Standalone,” on page 26
- “Configuring Permissions for vCenter Users,” on page 27
- “Support for IPv6 in Converter Standalone,” on page 28
- “TCP/IP and UDP Port Requirements for Conversion,” on page 28
- “Requirements for Remote Hot Cloning of Windows Operating Systems,” on page 30

Supported Operating Systems

You can install Converter Standalone components only on Windows operating systems. Converter Standalone
supports Windows and Linux operating systems as sources for powered-on-machine conversions and virtual-
machine conversions. You cannot reconfigure Linux distributions.

For a list of operating systems on which you can install Converter Standalone components, see Table 2-1.

Note: P2V conversion is not supported for UEFI source machines.

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows XP Professional (32-bit and 64-bit) SP3</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Windows 2003 (32-bit and 64-bit) SP2, Revision 2</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>
Table 2-1. Supported Operating Systems (Continued)

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows Vista (32-bit and 64-bit) SP2</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Windows Server 2008 (32-bit and 64-bit) SP2</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Windows Server 2008 R2 (64-bit)</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Windows 7 (32-bit and 64-bit)</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Red Hat Enterprise Linux 2.x (32-bit and 64-bit)</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Red Hat Enterprise Linux 3.x (32-bit and 64-bit)</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Red Hat Enterprise Linux 4.x (32-bit and 64-bit)</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Red Hat Enterprise Linux 5.x (32-bit and 64-bit)</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>SUSE Linux Enterprise Server 8.x (32-bit and 64-bit)</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>SUSE Linux Enterprise Server 9.x (32-bit and 64-bit)</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>SUSE Linux Enterprise Server 10.x (32-bit and 64-bit)</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>SUSE Linux Enterprise Server 11.x (32-bit and 64-bit)</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Ubuntu 8.x (32-bit and 64-bit)</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Ubuntu 9.x (32-bit and 64-bit)</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Ubuntu 10.x (32-bit and 64-bit)</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
</tbody>
</table>

Installation Space Requirements

During installation, you can select the Converter Standalone components that you want to install. All components require different amounts of free disk space to install.

Table 2-2 shows the disk space required to install Converter Standalone and its components.
Table 2-2. Installation Space Requirements

<table>
<thead>
<tr>
<th>Installation Component</th>
<th>Disk Space Required</th>
<th>Disk Space Requirement for Decompressed Files</th>
</tr>
</thead>
<tbody>
<tr>
<td>Installation file</td>
<td>100MB</td>
<td>100MB</td>
</tr>
<tr>
<td>vCenter Converter client</td>
<td>25MB</td>
<td>25MB</td>
</tr>
<tr>
<td>vCenter Converter server</td>
<td>120MB</td>
<td>300MB</td>
</tr>
<tr>
<td>vCenter Converter agent</td>
<td>25MB</td>
<td>100MB</td>
</tr>
</tbody>
</table>

Screen Resolution Requirements

To display wizards properly, Converter Standalone requires a screen resolution of at least 1024x768 pixels.

Supported Source Types

With Converter Standalone, you can convert remote powered-on machines, powered-off VMware virtual machines, Hyper-V virtual machines, and other third-party virtual machines and system images. Table 2-3 shows the sources that Converter Standalone supports.

Table 2-3. Supported Sources

<table>
<thead>
<tr>
<th>Source Type</th>
<th>Sources</th>
</tr>
</thead>
<tbody>
<tr>
<td>Powered-on machines</td>
<td>Remote Windows physical machines</td>
</tr>
<tr>
<td></td>
<td>Remote Linux physical machines</td>
</tr>
<tr>
<td></td>
<td>Local Windows physical machines</td>
</tr>
<tr>
<td></td>
<td>Windows virtual machines running on Hyper-V Server</td>
</tr>
<tr>
<td></td>
<td>Powered-on VMware virtual machines</td>
</tr>
<tr>
<td></td>
<td>VMware VCB backup images</td>
</tr>
<tr>
<td>VMware vCenter virtual</td>
<td>Powered-off virtual machines managed by the following servers:</td>
</tr>
<tr>
<td>machines</td>
<td>VirtualCenter 2.5</td>
</tr>
<tr>
<td></td>
<td>vCenter Server 4.0, 4.1, and 5.0</td>
</tr>
<tr>
<td></td>
<td>ESX Server 2.5.x (if VirtualCenter 2.5 or later manages ESX)</td>
</tr>
<tr>
<td></td>
<td>ESX Server 3.0, 3.5, 4.0, and 4.1</td>
</tr>
<tr>
<td></td>
<td>ESXi 3.5, 4.0, 4.1, and 5.0</td>
</tr>
<tr>
<td>VMware virtual machines</td>
<td>Powered-off hosted virtual machines running on the following VMware products:</td>
</tr>
<tr>
<td></td>
<td>VMware Workstation 5.x, 6.x, 7.x, and 8.x</td>
</tr>
<tr>
<td></td>
<td>VMware Fusion 2.x, 3.x, and 4.x</td>
</tr>
<tr>
<td></td>
<td>VMware Player 2.x and 3.x</td>
</tr>
<tr>
<td></td>
<td>VMware Server 2.x</td>
</tr>
</tbody>
</table>
### Table 2-3. Supported Sources (Continued)

<table>
<thead>
<tr>
<th>Source Type</th>
<th>Sources</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hyper-V Server virtual machines</td>
<td>Powered-off virtual machines with the following guest operating systems:</td>
</tr>
<tr>
<td></td>
<td>- Windows Server 2003 (x86 and x64), SP1, SP2, and R2</td>
</tr>
<tr>
<td></td>
<td>- Windows Server 2008 (x86 and x64) SP2 and R2 SP2</td>
</tr>
<tr>
<td></td>
<td>- Windows 7 (except Home editions)</td>
</tr>
<tr>
<td></td>
<td>- Windows Vista SP1 and SP2 (except Home editions)</td>
</tr>
<tr>
<td></td>
<td>- Windows XP Professional SP2, SP3, and x64 SP2</td>
</tr>
<tr>
<td></td>
<td>- SUSE Linux Enterprise Server 10 SP1 and SP2</td>
</tr>
<tr>
<td></td>
<td>- SUSE Linux Enterprise Server 11</td>
</tr>
<tr>
<td></td>
<td>- Red Hat Enterprise Linux 5.2, 5.3, and 5.4 (x86 and x64)</td>
</tr>
<tr>
<td>Third-party virtual machines or system images</td>
<td>- Acronis True Image Echo 9.1, 9.5, and Acronis True Image Home 10 and 11 (.tib).</td>
</tr>
<tr>
<td></td>
<td>- Symantec Backup Exec System Recovery (formerly LiveState Recovery) 6.5, 7.0, 8.0, and 8.5, LiveState Recovery 3.0 and 6.0 (only .sv2i).</td>
</tr>
<tr>
<td></td>
<td>- Norton Ghost version 10.0, 12.0, and 14.0 (.sv2i format only).</td>
</tr>
<tr>
<td></td>
<td>- Parallels Desktop 2.5, 3.0, and 4.0 (.pvs and .hdd). Compressed disks are not supported.</td>
</tr>
<tr>
<td></td>
<td>- Parallels Workstation 2.x (.pvs). Compressed disks are not supported. Parallels Virtuozzo Containers are not supported.</td>
</tr>
<tr>
<td></td>
<td>- StorageCraft ShadowProtect Desktop, ShadowProtect Server, ShadowProtect Small Business Server (SBS), ShadowProtect IT Edition, versions 2.0, 2.5, 3.0, 3.1, and 3.2 (.spf).</td>
</tr>
<tr>
<td></td>
<td>- Microsoft VHD format for the following sources:</td>
</tr>
<tr>
<td></td>
<td>- Microsoft Virtual PC 2004 and Microsoft Virtual PC 2007 (.vmc)</td>
</tr>
<tr>
<td></td>
<td>- Microsoft Virtual Server 2005 and 2005 R2 (.vmc)</td>
</tr>
</tbody>
</table>

Sources that run Windows 7 and Windows Server 2008 R2 can be converted to ESX 3.5 Update 5, ESX 4.0, or later destinations. ESX 3.5 Update 4 or earlier versions do not support Windows 7.

### Conversion Limitations for Powered-On Machines

When you convert a powered-on machine, some conversion features might not be available for certain source operating systems.

For a list of limitations dependent on the source operating system, see Table 2-4.

### Table 2-4. Limitations for Powered-On Machine Conversion

<table>
<thead>
<tr>
<th>Source Operating System</th>
<th>Limitations</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows XP and later</td>
<td>- Synchronization is supported only for volume-based cloning at the block level.</td>
</tr>
<tr>
<td></td>
<td>- Scheduling synchronization is supported only for managed destinations that are ESX 4.0 or later.</td>
</tr>
<tr>
<td>Linux</td>
<td>- Only volume-based cloning at the file level is supported.</td>
</tr>
<tr>
<td></td>
<td>- Only managed destinations are supported.</td>
</tr>
<tr>
<td></td>
<td>- Converting multiboot virtual machines is supported only if GRUB is installed as the boot loader. LILO is not supported.</td>
</tr>
</tbody>
</table>

### Conversion Limitations for VMware Virtual Machines

Certain limitations exist when you convert a VMware virtual machine.

You must power off source virtual machines before you convert them. You can convert running virtual machines if you follow the procedure for converting powered-on machines.

When you convert a virtual machine with VMware snapshots, the snapshots are not transferred to the destination virtual machine.
Certain limitations are applicable when you convert Linux virtual machine sources.

- Only disk-based cloning is supported for Linux guest operating systems.
- Configuration or customization is not supported for Linux guest operating systems.
- Installing VMware Tools is not supported on Linux guest operating systems.

**Conversion Limitations for Third-Party Virtual Machines or System Images**

Converter Standalone can convert third-party virtual machines, system images, ShadowProtect images, and Backup Exec System Recovery images. These conversions have limitations.

**Third-Party Virtual Machines and System Images**

Third-party virtual machines and system images have the following limitations.

- Virtual machines created with Macintosh versions of Virtual PC are not supported.
- The operating system on the source Virtual PC or Virtual Server virtual machine must be a Windows guest operating system supported by the destination VMware platform (for example, Workstation 5 or 6.0.x). For a list of supported operating systems, see the Guest Operating System Installation Guide.
- Converter Standalone supports Virtual PC and Virtual Server virtual machines with most Windows operating systems earlier than Windows NT 4.0 and with non-Windows operating systems (for example, Linux and DOS) only for cloning. Converter Standalone does not support configuring for these systems.
- Parallels Virtuozzo containers are not supported.

**ShadowProtect and Backup Exec System Recovery**

ShadowProtect and Backup Exec System Recovery have the following limitations.

- Dynamic disks are not supported.
- All images for the backup of a machine must be in a single folder. The source folder must not contain images that are not part of the backup.
- For volume-based cloning, all volumes in the disk up to the active and system volumes must be backed up. For example, if a disk has four partitions, 1 through 4, with partition 2 as the active volume and partition 3 as the system volume, the backup must include partitions 1 through 3.
- For incremental images, up to 16 incremental backups are supported.
- ShadowProtect images of systems with logical drives are not supported if the logical drive is also a system or active volume.

**Supported Destination Types**

With Converter Standalone, you can create virtual machines compatible with VMware hosted and managed products.

Table 2-5 shows the destinations that Converter Standalone supports.
Table 2-5. Supported Destinations

<table>
<thead>
<tr>
<th>Destination Type</th>
<th>Supported Versions</th>
</tr>
</thead>
<tbody>
<tr>
<td>VMware vCenter virtual machines</td>
<td>Managed destinations</td>
</tr>
<tr>
<td></td>
<td>• ESX Server 3.5, 4.0, and 4.1</td>
</tr>
<tr>
<td></td>
<td>• ESXi 3.5, 4.0, 4.1, and 5.0</td>
</tr>
<tr>
<td></td>
<td>• vCenter Server 2.5, 4.0, 4.1, and 5.0</td>
</tr>
<tr>
<td>VMware hosted virtual machines</td>
<td>Hosted destinations</td>
</tr>
<tr>
<td></td>
<td>• VMware Workstation 5.x, 6.x, 7.x, and 8.x</td>
</tr>
<tr>
<td></td>
<td>• VMware Fusion 2.x, 3.x, and 4.x</td>
</tr>
<tr>
<td></td>
<td>• VMware Player 2.x, and 3.0</td>
</tr>
<tr>
<td></td>
<td>• VMware Server 2.x</td>
</tr>
</tbody>
</table>

**Note** For hosted destinations that reside on SMB or NFS shares, you must use volume-based cloning and create 2GB disks that are not pre-allocated.

Restoring VCB Images in Converter Standalone

You can use VMware Consolidated Backup to back up all of the virtual machines of an entire ESX installation. The backup is stored by using Workstation disks, a .vmx file, and a catalog file. Converter Standalone can restore VCB images to ESX hosts and convert them to VMware standalone virtual machines.

Converter Standalone supports restore operations for VCB images of the source operating systems described in “Supported Operating Systems,” on page 21.

Converter Standalone does not maintain the .nvram file or the VMware log files.

Converter Standalone does not read the original location settings from the catalog file. To restore to the same location, find information such as datastore, host name, folder name, and resource pool in the catalog file and specify it in the Conversion wizard. In addition, Converter Standalone does not read the original display name from the catalog file. If you want to use the same name but do not remember it, you can look it up in the catalog file. You can read the catalog file as a plain text file.

Information Not Preserved When Using Converter Standalone for Managed Product Destinations

When you restore VCB images for managed product destinations (ESX hosts, for example), Converter Standalone does not preserve certain hardware backing information from the original image, but rather substitutes default settings.

**Table 2-6** shows the areas that are affected.

<table>
<thead>
<tr>
<th>Affected Area</th>
<th>Behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td>CD-ROM</td>
<td>Defaults to the client device type.</td>
</tr>
<tr>
<td>Floppy</td>
<td>Defaults to the client device type.</td>
</tr>
<tr>
<td>Network adapters</td>
<td>Defaults to the list of network adapters in the GUI. The MAC address is not preserved. The destination host regenerates the MAC address.</td>
</tr>
<tr>
<td>Serial port</td>
<td>Defaults to the physical serial port on destination host machine.</td>
</tr>
<tr>
<td>Parallel port</td>
<td>Defaults to the physical parallel port on destination host machine.</td>
</tr>
</tbody>
</table>

When you restore images, the Converter Standalone GUI does not preserve certain other virtual machine properties from the original image, but substitutes default settings. **Table 2-7** shows the affected areas.
Table 2-7. Changes to Properties Because of Conversion

<table>
<thead>
<tr>
<th>Affected Area</th>
<th>Behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td>UUID</td>
<td>The virtual machine's BIOS and location, identified by uuid.bios and uuid.location, are not preserved. The destination host machine regenerates the BIOS and location.</td>
</tr>
<tr>
<td>Disk resource allocation</td>
<td>Defaults to the values available on the host when the virtual machine is created.</td>
</tr>
</tbody>
</table>

Information Not Preserved for Hosted Product Destinations

When you import a VCB image to a hosted product destination (Workstation, for example), Converter Standalone cannot guarantee that virtual machine properties can be preserved. This behavior is because Converter Standalone handles this import as a migration, and not as a restore.

For more information about VCB images, see the Virtual Machine Backup Guide.

Configuring Permissions for vCenter Users

To convert virtual machines to vCenter Server machines with Converter Standalone, you must have certain vCenter Server permissions set at the datacenter level.

To start using Converter Standalone, you need to set a number of minimum privileges at the datacenter level.

- Datastore.Allocate space
- Datastore.Browse datastore
- Host.Local operations.Create virtual machine
- Host.Local operations.Delete virtual machine
- Host.Local operations.Reconfigure virtual machine
- Network.Assign network (required only if you plan to connect the destination virtual machine to a network)
- Resource.Assign virtual machine to resource pool
- Virtual machine.Configuration
- Virtual machine.Interaction.Power On (required only if you choose to power on the destination virtual machine after conversion)
- Virtual machine.Inventory
- Virtual machine.Provisioning.Allow disk access
- Virtual machine.Provisioning.Allow read-only disk access

Converting Linux and powered-on Windows machines might require a number of additional vCenter Server privileges.

- Virtual machine.Interaction.Configure CD media (required only if you need to boot a converted Linux virtual machine to install media after the conversion)
- Virtual machine.Snapshot management.Create snapshot (required only if you want to synchronize changes between the source and destination Windows virtual machine)
- Virtual machine.Snapshot management.Remove Snapshot (required only if you want to synchronize changes between the source and destination Windows virtual machine)

For more information about setting permissions, see the vSphere Datacenter Administration Guide.
Support for IPv6 in Converter Standalone

Converter Standalone supports both IPv4 and IPv6 Internet protocols with several limitations.

Internet Protocol version 6 (IPv6 or IPng) is the successor to Internet Protocol version 4 (IPv4), which is the currently used protocol for assigning IP addresses to computers on the Internet. IPv6 was adopted to overcome the expected exhaustion of IPv4 addresses that might be caused by the constantly increasing number of computers on the Internet.

While IPv4 uses 32-bit addresses, IPv6 uses 128-bit. IPv6 addresses can have different formats or notations.

- 1040:0:0:0:0:0:0:1
- 1040::1
- 21DA:00D3:0010:2F3B:02AA:00FF:FE28:9C5A
- [2001:0db8:85a3:08d3:1319:8a2e:0370:7344]:443

Converter Standalone supports all IPv6 notations for all components of the system.

- Converter Standalone installer
- Converter Standalone client
- Converter Standalone agent
- All destinations supported in Converter Standalone

Along with the higher security level and much larger address space, IPv6 brings about some compatibility tasks that have not been resolved yet. For example, IPv4-only nodes cannot communicate directly with IPv6 nodes and need additional routing. This makes the end-to-end support of mixed IPv4 and IPv6 environments precarious.

To reduce this complexity, Converter Standalone supports only pure IPv6 or IPv4 environments, where the protection source, the protection destination, and the Converter Standalone server and agent must run the same version of IP.

**NOTE**  You cannot use IPv6 to customize the guest operating systems of virtual machines.

TCP/IP and UDP Port Requirements for Conversion

To enable conversion, the Converter Standalone server and client must be able to send data to each other, to remote physical machines, and to vCenter Server. Also, the source and destination hosts must receive data from each other. Designated ports are reserved for this communication.

If any of these ports is blocked, the corresponding conversion task fails.

Ports Used When Converting a Powered-On Physical Machine Running Windows

Table 2-8 contains a list of the ports that must be open during the conversion of physical machine sources running Windows.
### Table 2-8. Ports Required During Windows P2V

<table>
<thead>
<tr>
<th>Communication Paths</th>
<th>Communication Ports</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Converter Standalone server to powered-on source machine</td>
<td>TCP - 445, 139, 9089 UDP - 137, 138</td>
<td>If the source computer uses NetBIOS, port 445 is not required. If NetBIOS is not being used, ports 137, 138, and 139 are not required. When in doubt, make sure that none of the ports are blocked. <strong>Note</strong>: Unless you have installed Converter Standalone server or agent on the source computer, the account used for authentication to the source computer must have a password, network file sharing must be enabled on the source computer, and Simple File Sharing must not be used.</td>
</tr>
<tr>
<td>Converter Standalone server to vCenter Server</td>
<td>TCP - 443</td>
<td>Required only if the conversion destination is a vCenter Server.</td>
</tr>
<tr>
<td>Converter Standalone client to vCenter Server</td>
<td>TCP - 443</td>
<td>Required only if the Converter Standalone server and client components are on different machines.</td>
</tr>
<tr>
<td>Powered-on source machine to ESX/ESXi</td>
<td>TCP - 443, 902</td>
<td>If the conversion destination is vCenter Server, only port 902 is required.</td>
</tr>
</tbody>
</table>

### Ports Used When Converting a Powered-On Physical Machine Running Linux

Table 2-9 contains a list of the ports that must be open during the conversion of physical machine sources running Linux.

### Table 2-9. Ports Required During Linux P2V

<table>
<thead>
<tr>
<th>Communication Paths</th>
<th>TCP Ports</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Converter Standalone server to powered-on source machine</td>
<td>22</td>
<td>Used to establish an SSH connection between the Converter Standalone server and the source machine.</td>
</tr>
<tr>
<td>Converter Standalone client to Converter Standalone server</td>
<td>443</td>
<td>Required only if the Converter Standalone server and client components are on different machines.</td>
</tr>
<tr>
<td>Converter Standalone server to vCenter Server</td>
<td>443</td>
<td>Required only if the conversion destination is a vCenter Server.</td>
</tr>
<tr>
<td>Converter Standalone server to ESX/ESXi</td>
<td>443, 902, 903</td>
<td>If the conversion destination is a vCenter Server, only ports 902 and 903 are required.</td>
</tr>
<tr>
<td>Converter Standalone server to helper virtual machine</td>
<td>443</td>
<td>Used to establish an SSH connection between the helper virtual machine and the source machine. By default, the IP address of the helper virtual machine is assigned by DHCP. If no DHCP server is available on the destination network, you must manually assign the target virtual machine an IP address.</td>
</tr>
<tr>
<td>Helper virtual machine to powered-on source machine</td>
<td>22</td>
<td>Used to establish an SSH connection between the helper virtual machine and the source machine. By default, the IP address of the helper virtual machine is assigned by DHCP. If no DHCP server is available on the destination network, you must manually assign the target virtual machine an IP address.</td>
</tr>
</tbody>
</table>

### Ports Used When Converting Virtual Machine Sources

Table 2-10 contains a list of the ports that must be open during the conversion of virtual machines.
Table 2-10. Ports Required During V2V

<table>
<thead>
<tr>
<th>Communication Paths</th>
<th>Communication Ports</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Converter Standalone server to Fileshare path</td>
<td>TCP - 445, 139</td>
<td>Required only for standalone virtual machine sources or destinations. If the computer hosting the source or destination path uses NetBIOS, port 445 is not required. If NetBIOS is not being used, ports 137, 138, and 139 are not required. When in doubt, make sure that none of the ports are blocked.</td>
</tr>
<tr>
<td></td>
<td>UPD - 137, 138</td>
<td></td>
</tr>
<tr>
<td>Converter Standalone client to Converter Standalone server</td>
<td>TCP - 443</td>
<td>Required only if the Converter Standalone server and client components are on different machines.</td>
</tr>
<tr>
<td>Converter Standalone server to vCenter Server</td>
<td>TCP - 443</td>
<td>Required only if the conversion destination is a vCenter Server.</td>
</tr>
<tr>
<td>Converter Standalone server to ESX/ESXi</td>
<td>TCP - 443, 902</td>
<td>If the conversion destination is a vCenter Server, only port 902 is required.</td>
</tr>
</tbody>
</table>

Requirements for Remote Hot Cloning of Windows Operating Systems

To avoid problems related to permissions and network access, ensure that simple file sharing is turned off and that Windows Firewall does not block file and printer sharing. Also, to access file and printer sharing ports, you might need to change the scope of the IP addresses that the firewall allows.

To ensure successful remote hot cloning of Windows platforms, verify the following items on the source machine before you start the application:

- Ensure that simple file sharing is turned off.
- Ensure that file and printer sharing is not blocked by Windows Firewall.

You must allow incoming file share connections in the following cases:

- When you use the machine to host standalone images
- When you use the machine as a standalone destination
- When you remotely hot clone the machine

To enable customization of the guest operating system, install Sysprep files on the machine where Converter Standalone server runs.

Ensure that Windows Firewall Does Not Block File and Printer Sharing

If Converter Standalone fails to connect to a remote Windows XP machine and issues a bad username/password error message, ensure that file and printer sharing is not blocked by Windows Firewall.

Procedure

2. In the Security Settings list on the left, select Local Policies > Security Options.
3. In the policies list on the right, select Network access: Sharing and Security model for local accounts.
4. Verify that Classic – local users authenticate as themselves is selected.

What to do next

For troubleshooting information about file and printer sharing, search the Microsoft TechNet Web site. For information about setting file and printer sharing on other Windows systems, see the documentation for your system.
### Turn Off Simple File Sharing on Windows XP Professional

To control permissions for individual users, you must turn off simple file sharing on the source machine.

Turning simple file sharing off does not turn off the Shared Documents feature. Use the simple file sharing UI, located in the folder’s properties, to configure share and file permissions.

For Windows XP Professional operating systems that are part of a workgroup, the simple file sharing UI is turned on by default. Windows XP Professional operating systems that are part of a domain use only the classic file sharing and security interface.

**Procedure**

1. On the source machine, select **Start > Settings > Control Panel > Folder Options**.
2. Click the **View** tab and deselect **Use Simple File Sharing (Recommended)**.

Simple file sharing is turned off.

**What to do next**

For more information about turning simple file sharing on or off, see the Microsoft TechNet Web site.

### Prepare Guest Operating System for Customization

To customize the guest operating system of a virtual machine that runs Windows Server 2003 or Windows XP, you must save the Sysprep files to the specified locations on the machine where Converter Standalone server runs.

If Sysprep files are missing from the server machine, the **Customize Guest OS** option is not accessible in the Converter Standalone wizards.

**Prerequisites**

You must download the Sysprep files that correspond to the operating system of the source machine.

**Procedure**

- Save the Sysprep files that correspond to the source operating system to the specified location on the machine where Converter Standalone server runs.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows Server 2003 (32bit)</td>
<td>The Sysprep files Location for Windows: %ALLUSERSPROFILE \Application Data\VMware\VMware vCenter Converter Standalone\sysprep\svr2003</td>
</tr>
<tr>
<td>Windows Server 2003 (64bit)</td>
<td>The Sysprep files Location for Windows: %ALLUSERSPROFILE \Application Data\VMware\VMware vCenter Converter Standalone\sysprep\svr2003-64</td>
</tr>
<tr>
<td>Windows XP (32bit)</td>
<td>The Sysprep files Location for Windows: %ALLUSERSPROFILE \Application Data\VMware\VMware vCenter Converter Standalone\sysprep\xp</td>
</tr>
<tr>
<td>Windows XP (64bit)</td>
<td>The Sysprep files Location for Windows: %ALLUSERSPROFILE \Application Data\VMware\VMware vCenter Converter Standalone\sysprep\xp-64</td>
</tr>
</tbody>
</table>

**What to do next**

You can now customize Windows Server 2003 (32bit and 64bit) and Windows XP (32bit and 64bit) guest operating systems by using the Conversion or the Configuration wizard.
**Limitations Related to Creating Snapshots of Windows Sources**

Converter Standalone uses VSS snapshots to save the state of source volumes during hot cloning of physical and virtual machines that run Windows. VSS snapshots are also used to synchronize the destination virtual machine with the source machine after the initial conversion. Some of the VSS-related issues are inherited in Converter Standalone and can prevent the proper completion of your conversion tasks.

Read the limitations listed in Table 2-11 before you initiate a conversion task.

If your conversion task fails with an VSS-related error message, you can check the table for possible reasons and workarounds.

**Table 2-11. VSS Snapshotting Limitations**

<table>
<thead>
<tr>
<th>VSS Limitations</th>
<th>Error Messages</th>
<th>Workarounds</th>
</tr>
</thead>
<tbody>
<tr>
<td>For all operating systems that support volume-based cloning, you need at least one NTFS volume for VSS to work.</td>
<td></td>
<td>There is no workaround for this limitation.</td>
</tr>
<tr>
<td>VSS under Windows Server 2008 does not support FAT and FAT32.</td>
<td></td>
<td>Deselect all FAT and FAT32 volumes on the View/Edit Options page of the vCenter Converter wizards.</td>
</tr>
<tr>
<td>VSS under Windows Server 2008 does not support unformatted or unrecognized volumes.</td>
<td>Failed to create VSS snapshot of source volume. Error code: 2147754764 (0x8004230C)</td>
<td>- Format all unformatted or unrecognized volumes and try the conversion again.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Deselect all unformatted or unrecognized volumes while setting up the conversion task in the Data to copy pane of the View/Edit Options page.</td>
</tr>
<tr>
<td>If the space in the VSS snapshot storage area is not enough for VSS to create a snapshot, the conversion fails.</td>
<td>Failed to create VSS snapshot of source volume. Error code: 2147754783 (0x8004231F)</td>
<td>Clean up the source volumes, especially the system volume and all NTFS volumes, and try to convert the source again.</td>
</tr>
</tbody>
</table>
| Importing powered-on Hyper-V sources fails if the following two VSS services are not started or are not operating properly on the source machine: | Failed to create VSS snapshot of source volume. Error code: 2147754758 (0x80042306) | 1. Set the starting mode for Microsoft Software Shadow Copy Provider Service and Volume Shadow Copy Service to Automatic.  
2. Restart the source machine and try cloning it again. |

- Microsoft Software Shadow Copy Provider Service
- Volume Shadow Copy Service

VMware vCenter Converter Standalone User's Guide

VMware, Inc.
Installing and Uninstalling Converter Standalone

You can install Converter Standalone on a physical or a virtual machine. You can also modify or repair a Converter Standalone installation.

The Local setup installs the Converter Standalone server, Converter Standalone agent, and Converter Standalone client for local use.

**NOTE** Local installation of Converter Standalone complies with the following security restrictions:
- After the initial setup, the use of an administrator account requires physical access to the product.
- You can manage Converter Standalone only from the machine where it is installed.

During the client-server installation, you can select the Converter Standalone components that you want to install on your system.

When you install the Converter Standalone server and Remote access, the local machine becomes a server for conversions, which you can manage remotely. When you install the Converter Standalone server and the Converter Standalone client, you can use the local machine to access remote Converter Standalone servers or create conversion jobs locally.

If you install only Converter Standalone client, you can connect to a remote Converter Standalone server. You can then use the remote machine to convert hosted virtual machines, managed virtual machines, or remote physical machines.

This chapter includes the following topics:
- “Perform a Local Installation on Windows,” on page 33
- “Perform a Client-Server Installation in Windows,” on page 34
- “Perform a Command-Line Installation in Windows,” on page 36
- “Command-Line Options for Windows Installation,” on page 36
- “Modify Converter Standalone in Windows,” on page 37
- “Repair Converter Standalone in Windows,” on page 38
- “Uninstall Converter Standalone in Windows,” on page 39
- “Connect to a Remote Converter Standalone Server,” on page 39

**Perform a Local Installation on Windows**

You can install Converter Standalone on a physical or a virtual machine. The local setup installs the Converter Standalone server, Converter Standalone agent, and Converter Standalone client for local use.

If you install Converter Standalone in local mode, you can create and manage conversion tasks only from the machine on which you installed the application.
Prerequisites

Make sure your system meets the Converter Standalone system requirements.

Make sure that you have Administrator privileges.

If you have Converter 3.0.x installed and your machine runs Windows Vista, uninstall Converter 3.0.x manually before you install Converter Standalone 5.0.

If you have an earlier version of Converter Standalone agent on the system, uninstall Converter Standalone agent.

Procedure

1 Download the latest version of Converter Standalone from the VMware Web site.

2 Navigate to the folder that contains the installer file you downloaded and double-click the *VMware-converter-5.x.x-<xxxxx>.exe* file, where `<xxxxx>` is the number of the build.

3 In the Choose Setup Language dialog box, select the language for the install process and click OK.

4 Follow the prompts till the End-User License Agreement page appears.

5 Select I accept the terms in the License agreement and click Next.

6 On the Destination Folder page, select the location to install Converter Standalone and click Next.

   The default location is *C:\Program Files\VMware\VMware vCenter Converter Standalone*. To install to another location, you can click Change and browse for the new location.

7 On the Setup Type page, select Local installation and click Next.

8 On the Ready to Install page, click Install.

9 (Optional) On the Installation Completed page, deselect Run Converter Standalone Client now to complete the installation without starting the application at this time.

10 On the Installation Completed page, click Finish.

   A prompt might ask you to restart your system.

Converter Standalone is installed on the local machine and is ready for use.

What to do next

You can use Converter Standalone to convert physical or virtual machine sources to virtual machine destinations.

Perform a Client-Server Installation in Windows

Perform a client-server installation so that you can create and manage conversion tasks remotely.

During the client-server installation, you can select the Converter Standalone components that you want to install on your system.

Prerequisites

Make sure your system meets the Converter Standalone system requirements.

Make sure that you have Administrator privileges.

If you have Converter 3.0.x installed and your machine runs Windows Vista, uninstall Converter 3.0.x manually before you install Converter Standalone 5.0.

If you have an earlier version of Converter Standalone agent on the system, uninstall Converter Standalone agent.
Chapter 3 Installing and Uninstalling Converter Standalone

Procedure

1. Download the latest version of Converter Standalone from the VMware Web site.

2. Navigate to the folder that contains the installer file you downloaded and double-click the `VMware-converter-5.x.x-<xxxxx>.exe` file, where `<xxxxx>` is the number of the build.

3. In the Choose Setup Language dialog box, select the language for the install process and click **OK**.

4. On the Setup Type page, select **Client-Server installation (advanced)** and click **Next**.

5. On the Custom Setup page, select the components that you want to install and click **Next**.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Converter server</td>
<td>Converter Standalone server manages the conversion tasks. It handles the communication between the Converter Standalone clients and Converter Standalone agents. You cannot install Converter server alone. You must install Converter Standalone server together with Remote access or with the Converter Standalone client, or with both.</td>
</tr>
<tr>
<td>Remote access</td>
<td>If you install Remote access, local and multiple remote Converter Standalone clients can connect to the local Converter Standalone server. With remote access you can create and manage conversion tasks remotely. For remote access, you must perform a client-server installation.</td>
</tr>
<tr>
<td>Converter agent</td>
<td>Install Converter Standalone agent to allow the local machine to be a source machine for conversions.</td>
</tr>
<tr>
<td>Converter client</td>
<td>If you install only Converter Standalone client, you can connect to remote Converter Standalone server. You can then use the remote machine to convert hosted virtual machines, managed virtual machines, or remote physical machines.</td>
</tr>
</tbody>
</table>

When you install the Converter Standalone server and Remote access, the local machine becomes a server for conversions, which you can manage remotely. When you install the Converter Standalone server and the Converter Standalone client, you can use the local machine to access remote Converter Standalone servers or create conversion jobs locally.

6. (Optional) If you decided to install Remote access or Converter Standalone agent, modify the Web service ports on the Port Settings page.
   - Type the HTTPS port service number.
   - Type the HTTP port service number.
   - Type the Agent port service number.

7. On the Ready to Install page, click **Install**.

8. (Optional) If you installed the Converter Standalone client, deselect **Run Converter Standalone Client now** to complete the installation without starting the application at this time.

9. On the Installation Completed page, click **Finish**.

   A prompt might ask you to restart your system.

The selected Converter Standalone components are installed on the local machine and are ready for use.

**What to do next**

You can use Converter Standalone to convert physical or virtual machine sources to virtual machine destinations.
Perform a Command-Line Installation in Windows

You can install Converter Standalone from the MS-DOS command prompt or by writing a Windows batch file (.bat) to automate the installation process.

Prerequisites

Make sure your system meets the Converter Standalone system requirements.
Make sure that you have Administrator privileges.
If you have Converter 3.0.x installed and your machine runs Windows Vista, uninstall Converter 3.0.x manually before you install Converter Standalone 5.0.
If you have an earlier version of Converter Standalone agent on the system, uninstall Converter Standalone agent.

Procedure

1. Download the latest version of Converter Standalone from the VMware Web site.
2. In the local directory to which you downloaded the installer, see the number of the build, which is a part of the installer filename.
3. At the command line, install Converter Standalone silently with the log file written to the temp directory.

   VMware-converter-<build>.exe /s /v"/qn ADDLOCAL=ALL /l*v %TEMP%\vmconvservermsi.log"

   For more command-line options, see "Command-Line Options for Windows Installation," on page 36.

What to do next

You can use Converter Standalone to convert physical or virtual machine sources to virtual machine destinations.

Command-Line Options for Windows Installation

You can use the command-line installation options when you install Converter Standalone from the MS-DOS command prompt in Windows or by writing a Windows batch file (.bat).

For a list of options to perform command-line installation, see Table 3-1.

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>/s</td>
<td>Does not display the Windows Installer version check.</td>
</tr>
<tr>
<td>/v&quot;params&quot;</td>
<td>Passes parameters to the msiexec.exe file.</td>
</tr>
<tr>
<td>/qn</td>
<td>Runs the msi command in silent mode.</td>
</tr>
<tr>
<td>/qb</td>
<td>Runs the msi command in basic mode.</td>
</tr>
<tr>
<td>/qf</td>
<td>Runs the msi command in full mode.</td>
</tr>
<tr>
<td>/l*v Logfile</td>
<td>Records login information in the file provided in Logfile.</td>
</tr>
<tr>
<td>/x</td>
<td>Uninstalls VMware vCenter Converter Standalone.</td>
</tr>
<tr>
<td>ADDLOCAL=&quot;ALL&quot;</td>
<td>Installs full package. The parameter is case-sensitive.</td>
</tr>
<tr>
<td>PROPERTY=property value</td>
<td>Sets the value of a property to property value.</td>
</tr>
<tr>
<td>VMCE_HTTP_PORT</td>
<td>Sets the HTTP port. The default is 80. Remote machines connect to the server through this port to download the Converter Standalone client.</td>
</tr>
</tbody>
</table>

Table 3-1. Command-Line Options
Table 3-1. Command-Line Options (Continued)

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>VMCE_HTTPS_PORT</td>
<td>Set the HTTPS port. The default is 443. Remote Converter Standalone clients connect to this port on the server and submit conversion tasks.</td>
</tr>
<tr>
<td>VMCE_AGENT_PORT</td>
<td>Sets an Agent port. The default is 9089. Remote Converter Standalone servers connect to this port to convert this machine.</td>
</tr>
</tbody>
</table>

Modify Converter Standalone in Windows

To change the installed Converter Standalone agent or the communication ports for the Converter Standalone components, you must modify the Converter Standalone installation.

**Prerequisites**

Make sure that you have Administrator privileges.

Close the Converter Standalone application before you start the installer wizard.

**Procedure**

1. To start the Converter Standalone installer, perform one of the following actions:
   - Go to the folder that contains the installer file and double-click the VMware-converter-5.x.x-<xxxxx>.exe file, where <xxxxx> is the number of the build. Check the number of the build to see if it matches the build you installed.
   - Select Add or Remove Programs from Control Panel, select Converter Standalone from the list, and click Change.

2. On the Welcome page of the installer wizard, click Next.

3. On the Program Maintenance page, select Modify and click Next.

4. On the Custom Setup page, select the components that you want to install and click Next.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Converter server</strong></td>
<td>Converter Standalone server manages the conversion tasks. It handles the communication between the Converter Standalone clients and Converter Standalone agents. You cannot install Converter server alone. You must install Converter Standalone server together with Remote access or with the Converter Standalone client, or with both.</td>
</tr>
<tr>
<td><strong>Remote access</strong></td>
<td>If you install Remote access, local and multiple remote Converter Standalone clients can connect to the local Converter Standalone server. With remote access you can create and manage conversion tasks remotely. For remote access, you must perform a client-server installation.</td>
</tr>
<tr>
<td><strong>Converter agent</strong></td>
<td>Install Converter Standalone agent to allow the local machine to be a source machine for conversions.</td>
</tr>
<tr>
<td><strong>Converter client</strong></td>
<td>If you install only Converter Standalone client, you can connect to remote Converter Standalone server. You can then use the remote machine to convert hosted virtual machines, managed virtual machines, or remote physical machines.</td>
</tr>
</tbody>
</table>

When you install the Converter Standalone server and Remote access, the local machine becomes a server for conversions, which you can manage remotely. When you install the Converter Standalone server and the Converter Standalone client, you can use the local machine to access remote Converter Standalone servers or create conversion jobs locally.
5 (Optional) If you decided to install Remote access or Converter Standalone agent, modify the Web service ports on the Port Settings page.
- Type the HTTPS port service number.
- Type the HTTP port service number.
- Type the Agent port service number.

6 On the Ready to Modify page, click Install.

7 (Optional) If you installed the Converter Standalone client, deselect Run Converter Standalone Client now to complete the installation without starting the application at this time.

8 On the Installation Completed page, click Finish.
   A prompt might ask you to restart your system.

The selected Converter Standalone components are installed on the local machine and are ready for use.

What to do next
You can use Converter Standalone to convert physical or virtual machine sources to virtual machine destinations.

Repair Converter Standalone in Windows
You can repair the Converter Standalone installation to check for and reinstall the Converter Standalone client or Converter Standalone agent.

Prerequisites
Make sure that you have Administrator privileges.
Close the Converter Standalone application before you start the installer wizard.

Procedure
1 To start the Converter Standalone installer, perform one of the following actions:
   - Go to the folder that contains the installer file and double-click the VMware-converter-5.x.x-<xxxxx>.exe file, where <xxxxx> is the number of the build. Check the number of the build to see if it matches the build you installed.
   - Select Add or Remove Programs from Control Panel, select Converter Standalone from the list, and click Change.

2 On the Welcome page of the installer wizard, click Next.

3 On the Program Maintenance page, select Repair and click Next.

4 On the Ready to Repair page, click Install.

5 On the Installation Completed page, click Finish.
   A prompt might ask you to restart your system.

What to do next
You can use Converter Standalone to convert physical or virtual machine sources to virtual machine destinations.
Uninstall Converter Standalone in Windows

You can uninstall Converter Standalone by using the Microsoft Windows Add or Remove Programs utility from the Control Panel or by using the VMware vCenter Converter Standalone installer wizard.

**Prerequisites**
Make sure that you have Administrator privileges.
Close the Converter Standalone application before you start the installer wizard.

**Procedure**
1. To start the Converter Standalone installer, perform one of the following actions:
   - Go to the folder that contains the installer file and double-click the `VMware-converter-5.x.x-<xxxxx>.exe` file, where `<xxxxx>` is the number of the build. Check the number of the build to see if it matches the build you installed.
   - Select **Add or Remove Programs** from Control Panel, select Converter Standalone from the list, and click **Change**.
2. On the Welcome page of the installer wizard, click **Next**.
3. On the Program Maintenance page, select **Remove** and click **Next**.
4. On the Ready to Remove page, click **Remove**.
5. On the Installation Completed page, click **Finish**.

   A prompt might ask you to restart your system.

Connect to a Remote Converter Standalone Server

You can use the Converter Standalone client to connect to a Converter Standalone server installed on a remote machine.

**Prerequisites**
Ensure that the Converter Standalone server and agent are installed on the remote machine.

**Procedure**
1. Start Converter Standalone.
2. Follow the procedure that is applicable for your installation type.

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Local installation</strong></td>
<td>a  Select Administration &gt; Connect to another server.</td>
</tr>
<tr>
<td></td>
<td>b  On the Converter Standalone login page, select <strong>Enter the IP address or host name of the Converter Standalone server.</strong></td>
</tr>
<tr>
<td></td>
<td>c  Provide the IP address and Administrator credentials, and click <strong>Login</strong>.</td>
</tr>
<tr>
<td><strong>Client-server installation with remote access</strong></td>
<td>a  On the Converter Standalone login page, select <strong>Enter the IP address or host name of the Converter Standalone server.</strong></td>
</tr>
<tr>
<td></td>
<td>b  Provide the IP address and Administrator credentials, and click <strong>Login</strong>.</td>
</tr>
</tbody>
</table>

**What to do next**

You can now use the remote Converter Standalone server to set up and manage conversion tasks.
Convert a Physical or Virtual Machine

You can create a conversion job to convert a physical or virtual machine to a variety of destinations. You can convert physical machines, VMware virtual machines, third-party backup images and virtual machines, and Hyper-V Server virtual machines into VMware standalone virtual machines or virtual machines that vCenter Server manages.

The approach you take for creating the conversion job is determined by the type of source and the type of destination that you select.

**Source type**

A powered-on physical or virtual machine, a VMware Infrastructure virtual machine running on an ESX host, or a standalone virtual machine.

Standalone virtual machines include VMware virtual machines, backup images, and third-party virtual machines, such as VMware Workstation, VMware Server, VCB, Acronis True Image, Microsoft Virtual PC, Virtual Server, Symantec Backup Exec Server Recovery (formerly known as LiveState Recovery), LiveState Recovery, StorageCraft, Parallels Desktop for Microsoft Windows and Mac OS, Parallels Workstation, and Norton Ghost (only .sv2i) images.

For a complete list of supported source types and product versions, see “Supported Source Types,” on page 23.

**Destination type**

ESX host, ESX host that vCenter Server manages, or a VMware standalone virtual machine.

For a complete list of supported destination types and product versions, see “Supported Destination Types,” on page 25.

**Procedure**

1. **Start the Wizard for a Conversion** on page 42

   The Conversion wizard guides you through the steps of creating a conversion job.

2. **Select a Source Machine to Convert** on page 42

   You can select from several source options for the type of machine to convert.

3. **Select a Destination for the New Virtual Machine** on page 48

   When you set up a conversion job, you must select a destination for the new virtual machine.

4. **Configure the Hardware of the Destination Virtual Machine** on page 51

   You can configure the virtual hardware resources that the destination virtual machine uses.

5. **Configure the Software on the Destination Virtual Machine** on page 63

   You can configure the guest operating system so that it is ready to operate in a virtual environment.
6 Configure the Conversion Job on page 69
You can configure the conversion process and select the behavior of the source and destination machine during and after conversion. You can change the status of the source and destination services only when the source machine is running a Windows operating system.

7 Review the Summary and Submit the Conversion Job on page 74
On the Summary page, you can view a summary of the conversion job before you add it to the job list.

Start the Wizard for a Conversion
The Conversion wizard guides you through the steps of creating a conversion job.

Procedure
1 Start the Converter Standalone application.
2 Click Convert Machine in the application menu.

The Conversion wizard opens on the Source System page.

What to do next
You can now select the source machine type to convert.

Select a Source Machine to Convert
You can select from several source options for the type of machine to convert.

Prerequisites
Before you select a source machine to convert, verify that it is listed in the list of supported source types. See “Supported Source Types,” on page 23.

- Select a Powered-On Windows Machine to Convert on page 43
  You can select a running (powered-on) Windows machine to convert. The source machine can be physical or virtual.
- Select a Powered-On Linux Machine to Convert on page 44
  You can select a powered-on Linux machine to convert. The source machine can be a physical or virtual machine.
- Select an ESX/ESXi or vCenter Server Virtual Machine to Convert on page 44
  You can convert a powered-off virtual machine that is located on an ESX/ESXi host, or on an ESX/ESXi host managed by vCenter Server.
- Select a VMware Hosted Virtual Machine to Convert on page 46
  You can convert a virtual machine created or used in a VMware hosted product, such as VMware Workstation, VMware Player, VMware Fusion, and VMware Server.
- Select a Backup Image or a Third-Party Virtual Machine to Convert on page 46
  You can select a backup image or a third-party virtual machine as the conversion source.
- Select a Hyper-V Server Virtual Machine to Convert on page 47
  You can convert virtual machines that Hyper-V Server manages.
Select a Powered-On Windows Machine to Convert

You can select a running (powered-on) Windows machine to convert. The source machine can be physical or virtual.

Prerequisites

Before you continue, you must prepare the source Windows machine for conversion.

- Make sure that the Windows version installed on the powered-on machine is supported. For a list of supported operating systems, see “Supported Operating Systems,” on page 21.
- Make sure that the Converter Standalone server machine has network access to the Windows source machine.
- Turn off firewall applications running on the source machine.
- Disable simple file sharing on the source Windows machine.
- Make sure that no other conversion job is using the source you select.
- Remove any VMware Converter 3.x installations manually from the source machine.
- If you plan to convert a powered-on machine by using IPv6, ensure that Converter Standalone server is installed on the Windows Vista, Windows Server 2008, or Windows 7 operating system.

Procedure

1. On the Source System page of the Conversion wizard, select Powered-on machine from the Select source type drop-down menu.

2. Select an option that corresponds to your source machine location.

<table>
<thead>
<tr>
<th>Source Location</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Local</td>
<td>Click This local machine. For local machines, the authorization is set to the current user and cannot be changed. If remote access is enabled during Converter Standalone installation, the local machine is treated as a remote physical machine.</td>
</tr>
</tbody>
</table>
| Remote          | a. Click A remote machine.  
|                 | b. Provide the IP address or name of the machine and administrator credentials.  
|                 | c. Select the operating system type from the OS Family drop-down menu. |

3. (Optional) Click View source details to see hardware and software information about the source machine.

4. Click Next.

   If Converter Standalone agent is not already installed on the source machine, a dialog box prompts you to confirm the installation and select an uninstallation method for Converter Standalone agent.

5. (Optional) Select the uninstallation procedure for Converter Standalone agent and click Yes.

   Converter Standalone agent is installed on the source machine.

Converter Standalone agent prepares the source machine for conversion.

What to do next

On the Destination System page you can select the destination type for the new virtual machine.
Select a Powered-On Linux Machine to Convert

You can select a powered-on Linux machine to convert. The source machine can be a physical or virtual machine.

You can convert powered-on machines that run Linux only if GRUB is installed as the boot loader on the source. LILO boot loader is not supported.

Prerequisites

Before you continue, you must prepare the source machine for conversion.

- Enable SSH on the source Linux machine.
- Make sure that you use the root account to convert a Linux powered-on machine.
- Make sure that vCenter Converter server machine has network access to the Linux source machine.
- Make sure that no other conversion job is using the source you select.
- To be able to convert multiboot virtual machines, make sure to install GRUB as the boot loader. LILO is not supported.

Procedure

1. On the Source System page of the Conversion wizard, select Powered-on machine from the Select source type drop-down menu.
2. Provide the IP address or DNS name and root credentials for the Linux machine you want to convert.
3. From the OS Family drop-down menu, select Linux.
4. Click Next.

Converter Standalone connects to the powered-on Linux machine and prepares it for conversion.

What to do next

On the Destination System page you can select the destination type for the new virtual machine.

Select an ESX/ESXi or vCenter Server Virtual Machine to Convert

You can convert a powered-off virtual machine that is located on an ESX/ESXi host, or on an ESX/ESXi host managed by vCenter Server.

You cannot convert a running or suspended virtual machine by using this procedure. For powered-on virtual machines, use the procedures for powered-on source machines.

If you connect to a vCenter Server that is part of an environment that contains multiple vCenter Server instances, Converter Standalone displays only ESX hosts managed directly by the currently connected vCenter Server.

Prerequisites

If the source machine that you want to convert resides on a VMware DRS cluster that vCenter Server manages, set VMware DRS Power Management (DPM) to manual so that DPM does not power off the ESX hosts used by Converter Standalone. When the conversion process completes, restore DPM to its original settings. For information about how to change DPM settings, see the Resource Management Guide.

Power off the source machine before the conversion.
Procedure

1. On the Source System page of the Conversion wizard, select **VMware Infrastructure virtual machine** from the **Select source type** drop-down menu.

2. Provide the IP address or host name and credentials for authentication with the ESX host or the vCenter Server, and click **Next**.

The Source Machine page appears, displaying the host name or IP address and the inventory of the ESX host or the vCenter Server.

**What to do next**

On the Source Machine page of the Conversion wizard, you can browse the virtual infrastructure inventory and select the virtual machine to convert.

**Specify the vCenter Server Virtual Machine to Convert**

If you choose to convert a virtual machine managed by a vCenter Server or ESX host, you must browse the inventory to locate the source virtual machine.

**Prerequisites**

On the Source System page of the Conversion wizard, select **VMware Infrastructure virtual machine** as the conversion source and click **Next** to proceed to the Source Machine page.

**Procedure**

1. (Optional) If you are connected to a vCenter Server, select a virtual machine view from the **Specify machine with** drop-down menu.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Hosts and Clusters</strong></td>
<td>The Inventory tree pane provides a view of hosts, clusters, resource pools, and vApps. If you select a host managed by a cluster, you see the full list of virtual machines and templates in the VM list view. If you select a standalone host or a cluster, you see only the virtual machines that are not deployed in the resource pools of that host or cluster.</td>
</tr>
<tr>
<td><strong>VMs and Templates</strong></td>
<td>The Inventory tree pane provides a view of datacenters and VM folders.</td>
</tr>
</tbody>
</table>

2. (Optional) If you are connected to a vCenter Server, select an object from the Inventory tree pane.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Hosts and Clusters</strong></td>
<td>Select cluster, ESX host, resource pool, or vApp.</td>
</tr>
<tr>
<td><strong>VMs and Templates</strong></td>
<td>Select datacenter or VM folder.</td>
</tr>
</tbody>
</table>

3. From the virtual machines list, select the virtual machine you want to convert.

   You can search for virtual machines in the VM list by typing one or more letters of their names in the **Search for name with** text box. You can clear your search by clicking **Clear**.

   **Note** If you connect to a vCenter Server that has a disconnected ESX instance (powered off, connected to another vCenter Server, or in maintenance mode), you cannot select a virtual machine from that ESX host.

4. (Optional) To refresh the Inventory, click **Refresh**.

5. (Optional) To view more details about a machine, select it and click **View source details**.

6. Click **Next** to proceed to the Destination System page.
What to do next

On the Destination System page you can select the destination type for the new virtual machine.

Select a VMware Hosted Virtual Machine to Convert

You can convert a virtual machine created or used in a VMware hosted product, such as VMware Workstation, VMware Player, VMware Fusion, and VMware Server.

Prerequisites

Verify that your source machine is a supported VMware Desktop products virtual machine “Supported Source Types,” on page 23.

If you plan to use a network path to locate the source, verify that the machine where Converter Standalone server runs has access to that network path.

Power off the source machine before the conversion.

Procedure

1. On the Source System page of the Conversion wizard, select VMware Workstation or other VMware virtual machine from the Select source type drop-down menu.

2. Locate the virtual machine source.

   - If you are connected to a remote Converter Standalone server, provide a network path to the source virtual machine file (.vmx) in the Virtual machine file text box. For example, \server\virtual_machines\virtual_machine.vmx.
   
   - If you are connected to a local Converter Standalone server, provide a network path or a local path to the .vmx file.

   The file type choices are limited to VMware Workstation *.vmx files.

3. If you are connected to a remote Converter Standalone server, enter user credentials for accessing the source virtual machine.

   You do not have to provide user credentials if you are connected to a local Converter Standalone server. In such cases, Converter Standalone uses the Windows credentials to connect to the source machine.

4. (Optional) To view more information about the selected source, click View source details

5. Click Next to proceed to the Destination System page.

What to do next

On the Destination System page you can select the destination type for the new virtual machine.

Select a Backup Image or a Third-Party Virtual Machine to Convert

You can select a backup image or a third-party virtual machine as the conversion source.

Prerequisites

Verify that your machine is a supported backup image or third-party virtual machine here “Supported Source Types,” on page 23.

If you plan to use a network path to locate the source, verify that the machine where Converter Standalone server runs has access to that network path.

Power off the source machine before the conversion.
Procedure

1. On the Source System page, select **Backup image or third-party virtual machine** from the **Select source type** drop-down menu.

2. Locate the source backup image or virtual machine file.
   - If you are connected to a remote Converter Standalone server, provide a valid network path to the source backup image or virtual machine file in the **Virtual machine file** text box. For example, `\server\backup_images\backup_image.pvs`.
   - If you are connected to a local Converter Standalone server, provide a network path or a local path to the source backup image or virtual machine file.

3. If you are connected to a remote Converter Standalone server, enter user credentials for accessing the source virtual machine.
   You do not have to provide user credentials if you are connected to a local Converter Standalone server. In such cases, Converter Standalone uses the Windows credentials to connect to the source machine.

4. (Optional) To view more information about the selected source, click **View source details**.

5. Click **Next** to proceed to the Destination System page.

**What to do next**

On the Destination System page you can select the destination type for the new virtual machine.

**Select a Hyper-V Server Virtual Machine to Convert**

You can convert virtual machines that Hyper-V Server manages.

**Prerequisites**

Power off the source Hyper-V virtual machine.

**Procedure**

1. On the Source System page, select **Hyper-V Server** from the **Select source type** drop-down menu.

2. Provide the IP address or DNS name and administrative credentials to authenticate with the Hyper-V Server and click **Next**.
   - If Converter Standalone agent is not already installed on the Hyper-V Server, a dialog box appears. In it, you confirm the installation of Converter Standalone agent.

3. (Optional) Select an uninstallation procedure for Converter Standalone agent and click **Yes**.
   - Converter Standalone agent is installed on the source Hyper-V Server.

**What to do next**

On the Source Machine page, browse the Hyper-V Server inventory to locate the source virtual machine to convert.

**Specify the Hyper-V Server Virtual Machine to Convert**

If you choose to convert a virtual machine managed by a Hyper-V Server, you must browse the inventory to locate the source virtual machine.

**Prerequisites**

On the Source System page, select **Hyper-V Server** as the source type and navigate to the Source Machine page.
Procedure

1. On the Source Machine page, select the virtual machine you want to convert.

   You can search for virtual machines in the inventory by typing one or more letters of their names in the Search for name with text box. You can clear your search by clicking Clear.

   **Note** You can select only powered-off virtual machines. To convert a running machine, select a powered-on machine. To convert a suspended machine, either power it off and use the current procedure, or power it on and select a powered-on machine as the source.

2. (Optional) To refresh the inventory, click Refresh.

3. (Optional) To view more details about the virtual machine to convert, click View source details.

4. Click Next to proceed to the Destination System page.

The Converter Standalone agent prepares the Hyper-V source machine for conversion.

**What to do next**

On the Destination System page you can select the destination type for the new virtual machine.

### Select a Destination for the New Virtual Machine

When you set up a conversion job, you must select a destination for the new virtual machine.

When you use a VMware DRS cluster as the destination, you must set VMware DRS Power Management (DPM) to manual. This setting ensures that DPM does not power off the ESX hosts that Converter Standalone uses. When the conversion process completes, restore DPM to its original settings. For information about how to change DPM settings, see the Resource Management Guide.

**Note** For conversions of powered-on source machines that run Linux, the only supported destination is a VMware Infrastructure destination.

### Select a Managed Destination

You can convert a virtual machine to use with ESX/ESXi or with an ESX/ESXi host that vCenter Server manages.

**Procedure**

1. On the Destination System page, select VMware Infrastructure virtual machine from the Select destination type drop-down menu.

2. Provide the IP address or host name and credentials for authentication with the ESX host or the vCenter Server.

3. Click Next to proceed to the Destination Virtual Machine page.

**What to do next**

On the Destination Virtual Machine page, you can specify the name of the destination virtual machine and select the folder in which it should reside.

### Name the Destination Virtual Machine and Select a Folder

For VMware Infrastructure destinations, you can select the destination folder and rename the destination virtual machine.

If you connect to an ESX host directly, you can view only the list of virtual machines. Therefore, you cannot select a destination folder.
Prerequisites

On the Destination System page of the Conversion wizard, select **VMware Infrastructure virtual machine** as the destination type.

Procedure

1. On the Destination Virtual Machine page, select the datacenter to accommodate the destination virtual machine.
   
   If you use folders in your virtual environment to manage groups of virtual machines, you can select a folder to accommodate the destination virtual machine.

2. In the **Name** text box, enter a name for the destination virtual machine.
   
   By default, Converter Standalone assigns the source machine name in this text box.

   **NOTE** Search the list of virtual machines in the datacenter or folder you selected to ensure that the name you assign to the destination virtual machine does not exist. Virtual machines are filtered as you type. You can clear your search by clicking **Clear**.

3. (Optional) To refresh the Inventory, click **Refresh**.

4. Click **Next** to proceed to the Destination Location page.

What to do next

On the Destination Location page you can modify the destination environment for the new virtual machine. This includes selecting a host, resource pool, or cluster to accommodate the destination virtual machine, selecting the Datastore to hold the files of the destination virtual machine, and selecting the virtual hardware version to install on the destination virtual machine.

Customize the Location of the Destination Virtual Machine

For VMware Infrastructure destinations, you can select an ESX host, a resource pool, or a cluster. You can also select a datastore and the virtual hardware version to be installed on the destination.

Prerequisites

On the Destination Virtual Machine page, name the destination virtual machine. If the destination is a vCenter Server, select the destination folder.

Procedure

1. On the Destination Location page of the Conversion wizard, select a datacenter object from the inventory to accommodate the destination virtual machine.
   
   - Select an ESX host.
   - Select a resource pool.
   - Select a cluster.
   
   On the selected cluster, if DRS is not running in the automated mode, you can select an ESX host that belongs to the selected cluster from the **Host** drop-down menu.

2. (Optional) From the **Datastore** drop-down menu, select the datastore to hold the destination virtual machine files.
3 (Optional) From the Virtual machine version drop-down menu, select the virtual hardware version for the destination virtual machine.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Version 4</td>
<td>Select if the destination host is running ESX 3.x.</td>
</tr>
<tr>
<td>Version 7</td>
<td>Select if the destination host is running ESX 4.x or later.</td>
</tr>
<tr>
<td>Version 8</td>
<td>Select if the destination host is running ESX 5.x or later.</td>
</tr>
</tbody>
</table>

4 Click Next to proceed to the Options page.

What to do next

On the Options page you can set up the parameters of the conversion task. These settings include data layout, network settings, and guest operating system customization.

Select a Hosted Destination

You can convert a virtual machine for use with VMware Workstation, VMware Fusion, VMware Server, or VMware Player.

Prerequisites

If you plan to use a network path to locate the destination, verify that you have access to that network path.

- For powered-on machines or Hyper-V virtual machine sources, verify that the machine where Converter Standalone agent runs has access to that network path.
- For all other source types, verify that the machine where Converter Standalone server runs has access to that network path.

Procedure

1 On the Destination System page, select VMware Workstation or other VMware virtual machine from the Select destination type drop-down menu.
2 Select the destination VMware hosted product from the Select VMware product drop-down menu.
3 Provide a name for the destination virtual machine in the Name text box.
4 Specify the location to store the destination virtual machine files.
   - If you are connected to a remote Converter Standalone server, provide a network path to the destination directory. For example, \server\virtual_machines\.
   - If you are connected to a local Converter Standalone server, provide a network path or a local path to the destination directory.
5 (Optional) If the destination directory is password-protected, provide valid user credentials.
   You do not have to provide user credentials if the destination location is on the local storage of the machine where Converter Standalone server runs.
6 Click Next to proceed to the Options page.

What to do next

On the Options page you can set up the parameters of the conversion task. These settings include data layout, network settings, and guest operating system customization.
Configure the Hardware of the Destination Virtual Machine

You can configure the virtual hardware resources that the destination virtual machine uses.

- Organize the Data to Copy on the Destination Machine on page 51
  Depending on the selected source and destination, you can either create linked clones, or select between disk-based and volume-based cloning modes. For the conversion job, you can copy all disks to the destination or select the volumes to be copied or to be excluded. For destinations with multiple datastores, you can select the data location on specific datastores in your virtual environment.

- Edit the Number of Processor Sockets and Cores on page 60
  You can change the number of virtual sockets and the number of processor cores per socket that the destination virtual machine uses.

- Allocate Memory for the Destination Virtual Machine on page 61
  You can change the amount of memory allocated to the destination virtual machine.

- Specify a Disk Controller for the Destination Virtual Machine on page 62
  You can select a disk controller type for the destination virtual disks.

- Configure the Network Settings of the Destination Virtual Machine on page 62
  You can change the number of network adapters and select the network that the destination virtual machine uses. You can also set network adapters to connect to the network when the destination virtual machine powers on.

- Configure the Network for the Helper Virtual Machine on page 63
  When you convert a powered-on Linux machine, Converter Standalone creates a Helper virtual machine on the destination. The Helper virtual machine needs network access to the source machine to clone the source files. Default conversion settings enforce automatic acquisition of an IPv4 address and a DNS server for the Helper virtual machine, but you can set up this network connection manually.

Organize the Data to Copy on the Destination Machine

Depending on the selected source and destination, you can either create linked clones, or select between disk-based and volume-based cloning modes. For the conversion job, you can copy all disks to the destination or select the volumes to be copied or to be excluded. For destinations with multiple datastores, you can select the data location on specific datastores in your virtual environment.

**IMPORTANT** Converter Standalone cannot detect any source volumes and file systems that are located on physical disks larger than 2TB.

**Prerequisites**

On the Options page of the Conversion wizard, click **Data to copy** in the options list.
**Procedure**

- In the Data to copy pane, select a copy mode from the **Data copy type** drop-down menu.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy all disks and maintain layout</td>
<td>Results in disk-based cloning. You can preserve the source disk layout in the destination virtual machine. This option is not available for physical machine sources.</td>
</tr>
<tr>
<td>Select volumes to copy</td>
<td>Results in volume-based cloning. Volume-based cloning is performed at file or block level. You can select the volumes to be copied to the destination virtual machine. You can also resize and reorganize the volume layout. This option is available for powered-on source machines that run Windows and Linux, and for all other supported sources that run Windows.</td>
</tr>
<tr>
<td>Linked clone</td>
<td>A linked clone allows you to create a VMware virtual machine that shares the virtual disk of the source machine or system image. This option is available for hosted sources and hosted destinations.</td>
</tr>
</tbody>
</table>

Depending on the destination you select, several destination disk types are available. To support destination virtual disks on FAT file systems, divide the source data into 2GB files. For detailed information about destination virtual disks types, see “**Destination Disk Types,”** on page 17.

**Resize a Volume**

To manage disk space on the destination datastore, you can resize the disk volumes before you begin the conversion.

**Prerequisites**

On the Options page of the Conversion wizard, click **Data to copy** in the options list.

**Procedure**

1. From the **Data copy type** drop-down menu, select **Select volumes to copy**.
2. In the Destination size column, select an option to specify the size of a destination volume.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maintain size</td>
<td>Maintains the original source volume size.</td>
</tr>
<tr>
<td>Min size</td>
<td>Copies only the used space of the source volume.</td>
</tr>
<tr>
<td>Type size in GB</td>
<td>Allows you to type a custom size in GB for the destination volume. The value cannot be smaller than the used space on the source volume, but can be larger than the total size of the source volume. The maximum allowed disk size for the destination is 999GB.</td>
</tr>
<tr>
<td>Type size in MB</td>
<td>Allows you to type a custom size in MB for the destination volume. The value cannot be smaller than the used space on the source volume, but can be larger than the total size of the source volume. The maximum allowed disk size for the destination is 999GB.</td>
</tr>
</tbody>
</table>

3. Save your settings.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select another option from the options list</td>
<td>Saves your settings and displays the pane for the selected option.</td>
</tr>
<tr>
<td><strong>Click Next</strong></td>
<td>Saves your settings and displays the next page of the Conversion wizard.</td>
</tr>
<tr>
<td></td>
<td>The Customizations page is displayed if you select <strong>Customize guest preferences for the virtual machine</strong> in the Advanced options pane.</td>
</tr>
<tr>
<td></td>
<td>The Summary page is displayed if you do not select <strong>Customize guest preferences for the virtual machine</strong> in the Advanced options pane.</td>
</tr>
</tbody>
</table>
Change a Volume Cluster Size

To enhance performance and storage space, you can change the volume cluster size before the conversion. Modifying the cluster size changes the cloning mode from block level to file level.

Prerequisites

On the Options page of the Conversion wizard, click Data to copy in the options list. Ensure that the source is a Windows machine.

Procedure

1. From the Data copy type drop-down menu, select Select volumes to copy.
2. Click Advanced and select the Destination layout tab.
3. Select the volume for which you want to change the cluster size.
4. In the Cluster size column, select an option to specify the cluster size of the destination volume.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default cluster size</td>
<td>Applies a default cluster size to the destination volume.</td>
</tr>
<tr>
<td>Keep source cluster size</td>
<td>Preserves the cluster size of the original source volume.</td>
</tr>
<tr>
<td>Select a predefined size</td>
<td>Allows you to select a cluster size for the destination volume from a list of supported values.</td>
</tr>
</tbody>
</table>

In the Copy type column, you can verify that the cloning operation type is set to file level.
5. Save your settings.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select another option from the options list</td>
<td>Saves your settings and displays the pane for the selected option.</td>
</tr>
<tr>
<td>Click Next</td>
<td>Saves your settings and displays the next page of the Conversion wizard.</td>
</tr>
<tr>
<td></td>
<td>■ The Customizations page is displayed if you select Customize guest preferences for the virtual machine in the Advanced options pane.</td>
</tr>
<tr>
<td></td>
<td>■ The Summary page is displayed if you do not select Customize guest preferences for the virtual machine in the Advanced options pane.</td>
</tr>
</tbody>
</table>

Exclude a Source Volume from the Conversion Process

You can choose not to copy a volume from the source machine to the destination virtual machine. During the conversion process, Converter Standalone ignores the deselected volumes and copies only the volumes that are selected.

The source virtual machine must have more than one volume to be able to deselect existing volumes.

You cannot delete the system volume from the destination virtual machine. For example, if C: is the volume that contains the Windows operating system installation, you cannot remove it from the destination virtual machine.

Prerequisites

On the Options page of the Conversion wizard, click Data to copy in the options list.

Procedure

1. From the Data copy type drop-down menu, select Select volumes to copy.
2. Deselect the volumes that you do not want to copy to the destination virtual machine.
3 Save your settings.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select another option from the options list</td>
<td>Saves your settings and displays the pane for the selected option.</td>
</tr>
<tr>
<td>Click Next</td>
<td>Saves your settings and displays the next page of the Conversion wizard.</td>
</tr>
<tr>
<td></td>
<td>- The Customizations page is displayed if you select <strong>Customize guest</strong></td>
</tr>
<tr>
<td></td>
<td>preferences for the virtual machine in the Advanced options pane.</td>
</tr>
<tr>
<td></td>
<td>- The Summary page is displayed if you do not select <strong>Customize guest</strong></td>
</tr>
<tr>
<td></td>
<td>preferences for the virtual machine in the Advanced options pane.</td>
</tr>
</tbody>
</table>

The deselected volumes are ignored during the conversion process and do not appear on the destination virtual machine.

**Move a Volume to a Different Virtual Disk**

You can add virtual disks to the destination virtual machine and move source volumes in the new disks.

The number of virtual disks you can create depends on the number of volumes that exist on the source virtual machine. For example, if you have only one volume on the source virtual machine, you cannot add a virtual disk to the destination virtual machine.

You cannot move the system volume where the guest operating system is installed. For example, if your Windows operating system is installed on `C:`, you cannot move the `C:` volume.

**Prerequisites**

On the Options page of the Conversion wizard, click **Data to copy** in the options list.

**Procedure**

1. From the **Data copy type** drop-down menu, select **Select volumes to copy**.
2. Click **Advanced** and select the **Destination layout** tab.
3. Select a volume from the list and click **Add disk**.
   
   A new virtual disk appears in the Destination layout column.
4. Select a source volume and use the **Move up** and **Move down** buttons to accommodate the volume in the new virtual disk.
   
   If you leave the new virtual disk empty, Converter Standalone does not create the new virtual disk on the destination virtual machine.

The selected source volume is copied to a new virtual disk on the destination virtual machine.

**Select the Destination Datastore for a Source Volume**

You can store a disk volume in a datastore different from the one that accommodates the virtual machine configuration file (`*.vmx`).

You can select the destination datastore for a volume only for managed destinations with more than one datastore.

**Prerequisites**

On the Options page of the Conversion wizard, click **Data to copy** in the options list.

**Procedure**

1. From the **Data copy type** drop-down menu, select **Select volumes to copy**.
2 Click **Advanced** and select the **Destination layout** tab.

3 Select a volume from the list and click **Add disk**.

   A new virtual disk appears in the Destination layout column.

4 Select a source volume and use the **Move up** and **Move down** buttons to accommodate the volume in the new virtual disk.

   If you leave the new virtual disk empty, Converter Standalone does not create the new virtual disk on the destination virtual machine.

5 Highlight the new virtual disk and select a different datastore from the **Destination datastore** drop-down menu.

6 Save your settings.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select another option from the options list</td>
<td>Saves your settings and displays the pane for the selected option.</td>
</tr>
<tr>
<td>Click Next</td>
<td>Saves your settings and displays the next page of the Conversion wizard.</td>
</tr>
<tr>
<td></td>
<td>- The Customizations page is displayed if you select <strong>Customize guest preferences for the virtual machine</strong> in the Advanced options pane.</td>
</tr>
<tr>
<td></td>
<td>- The Summary page is displayed if you do not select <strong>Customize guest preferences for the virtual machine</strong> in the Advanced options pane.</td>
</tr>
</tbody>
</table>

The virtual disk file (`.vmdk`) that contains the volume is stored in the selected datastore.

**Add a Virtual Disk**

You can add a virtual disk to the destination virtual machine.

The number of virtual disks depends on the number of volumes that exist on the source virtual machine. For example, if you have only one volume on the source virtual machine, you cannot add a virtual disk to the destination virtual machine.

**Prerequisites**

You must have more than one volumes on the source machine to be able to add an additional virtual disk.

On the Options page of the Conversion wizard, click **Data to copy** in the options list.

**Procedure**

1 From the **Data copy type** drop-down menu, select **Select volumes to copy**.

2 Click **Advanced** and select the **Destination layout** tab.

3 Select a volume from the list and click **Add disk**.

   A virtual disk is added to the destination disk layout.

4 Select a source volume and use the **Move up** and **Move down** buttons to accommodate the volume in the new virtual disk.

   If you leave the new virtual disk empty, Converter Standalone does not create the new virtual disk on the destination virtual machine.
Save your settings.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select another option from the options list</td>
<td>Saves your settings and displays the pane for the selected option.</td>
</tr>
<tr>
<td>Click Next</td>
<td>Saves your settings and displays the next page of the Conversion wizard.</td>
</tr>
<tr>
<td></td>
<td>- The Customizations page is displayed if you select Customize guest preferences for the virtual machine in the Advanced options pane.</td>
</tr>
<tr>
<td></td>
<td>- The Summary page is displayed if you do not select Customize guest preferences for the virtual machine in the Advanced options pane.</td>
</tr>
</tbody>
</table>

The new virtual disk is created on the destination datastore.

**Set Up a Virtual Disk as a Logical-Volume Group Container**

To preserve the LVM structure when converting a Linux source, you can set up a virtual disk as a logical-volume container. Converter Standalone allows you to preserve and modify the source LVM structure. You can manage logical volumes and logical-volume groups in the same way as basic volumes and disks. Logical-volume groups are listed together with virtual disks and are marked with a different icon. You cannot move active and system volumes in a logical-volume group.

**Prerequisites**

Ensure that the source is a Linux machine and supports LVM. Only LVM2 is supported.

**Procedure**

1. From the Data copy type drop-down menu, select Select volumes to copy.
2. Click Advanced and select the Destination layout tab.
3. Select a disk and click To LVG.

**Move a Disk to a Different Datastore**

You can use disk-based cloning to select a different datastore for a destination virtual disk.

**Prerequisites**

On the Options page of the Conversion wizard, click Data to copy in the options list. You can change the destination datastore for a disk only for managed destinations with more than one datastore.

**Procedure**

1. From the Data copy type drop-down menu, select Copy all disks and maintain layout.
2. Click the name of the virtual disk to relocate and select a different datastore from the Destination datastore drop-down menu.
Save your settings.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select another option from the options list</td>
<td>Saves your settings and displays the pane for the selected option.</td>
</tr>
<tr>
<td>Click Next</td>
<td>Saves your settings and displays the next page of the Conversion wizard.</td>
</tr>
<tr>
<td></td>
<td>- The Customizations page is displayed if you select Customize guest preferences for the virtual machine in the Advanced options pane.</td>
</tr>
<tr>
<td></td>
<td>- The Summary page is displayed if you do not select Customize guest preferences for the virtual machine in the Advanced options pane.</td>
</tr>
</tbody>
</table>

The virtual disk file (.vmdk) is stored in the selected datastore.

Create an Expandable Disk on a Managed Destination

To save space on the destination datastore, you can copy only the existing data from a source virtual disk and create an expandable disk on the destination. Later, as you use the destination virtual machine and write new data, the destination virtual disk grows.

You can create expandable disks on managed destinations that support thin provisioning through their GUI.

You can create an expandable disk by using volume-based or disk-based cloning.

Prerequisites

On the Options page of the Conversion wizard, click Data to copy in the options list.

Procedure

- Use disk-based cloning to create an expandable disk.
  a. From the Data copy type drop-down menu, select Copy all disks and maintain layout.
  b. Click a virtual disk and select Thin from the Type drop-down menu.
  c. To apply your settings, select another option from the options list or click Next.

- Use volume-based cloning to create an expandable disk.
  a. From the Data copy type drop-down menu, select Select volumes to copy and click Advanced.
  b. Select the Destination layout tab, click a virtual disk, and select Thin from the Type drop-down menu.
  c. To apply your settings, select another option from the options list or click Next.

Converter Standalone copies only the existing data to the destination datastore. The empty disk space from the virtual disk is not copied to the datastore. As you use the destination virtual machine and write new data to the disk, the size of the destination disk grows.

Create an Expandable Disk on a Hosted Destination

To save space on the destination, you can copy only the existing data from a source virtual disk. Later, as you use the destination virtual machine and write new data, the destination virtual disk grows.

You can create an expandable disk by using volume-based or disk-based cloning.

Prerequisites

You must select a hosted destination, such as VMware Workstation, to use the Not pre-allocated disk option.

On the Options page of the Conversion wizard, click Data to copy in the options list.
Procedure

- Use disk-based cloning to create an expandable disk.
  a. From the Data copy type drop-down menu, select Copy all disks and maintain layout.
  b. From the Type drop-down menu, select Not pre-allocated.
  c. To apply your settings, select another option from the options list or click Next.

- Use volume-based cloning to create an expandable disk.
  a. From the Data copy type drop-down menu, select Select volumes to copy and click Advanced.
  b. Select the Destination layout tab, select a virtual disk, and select Not pre-allocated from the Type drop-down menu.
  c. To apply your settings, select another option from the options list or click Next.

Converter Standalone copies only the existing data to the destination datastore. The empty disk space from the virtual disk is not copied to the datastore. As you use the destination virtual machine and write new data to the disk, the size of the destination disk grows.

Exclude a Source Disk from the Conversion Process

You can select a disk from the source machine and delete it from the disk layout of the destination virtual machine.

Prerequisites

The source machine must have more than one hard disk.

On the Options page of the Conversion wizard, click Data to copy in the options list.

Procedure

1. From the Data copy type drop-down menu, select Select volumes to copy.
2. Delete the disk.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Preserve the volumes associated with the disk | a. Click Advanced and select the Destination layout tab.  
b. Move the volumes from the disk that you want to delete to another virtual disks.  
c. Highlight the empty disk and click Remove disk. |
| Delete the volumes associated with the disk | a. Click Advanced and select the Source volumes tab.  
b. Deselect the volumes associated with the disk that you want to delete. |

3. Save your settings.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select another option from the options list</td>
<td>Saves your settings and displays the pane for the selected option.</td>
</tr>
</tbody>
</table>
| Click Next                            | Saves your settings and displays the next page of the Conversion wizard.  

- The Customizations page is displayed if you select Customize guest preferences for the virtual machine in the Advanced options pane.
- The Summary page is displayed if you do not select Customize guest preferences for the virtual machine in the Advanced options pane.

Converter Standalone creates .vmdk files in the destination datastore only for the virtual disks you decided to preserve.
Copy All Disks to the Destination

To preserve the source disks on the destination virtual machine, you can copy all disks to the destination. Disk-based cloning is not available for powered-on machine sources.

Prerequisites

On the Options page of the Conversion wizard, click **Data to copy** in the options list.

Procedure

1. From the **Data copy type** drop-down menu, select **Copy all disks and maintain layout**.

2. (Optional) If the destination datastore is low on disk space, click a virtual disk and select a different datastore from the **Destination datastore** drop-down menu.

   **NOTE** You must have access to more than one datastore to move a disk to a different datastore.

3. Save your settings.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select another option from the options list</td>
<td>Saves your settings and displays the pane for the selected option.</td>
</tr>
<tr>
<td>Click Next</td>
<td>Saves your settings and displays the next page of the Conversion wizard.</td>
</tr>
<tr>
<td></td>
<td>- The Customizations page is displayed if you select <strong>Customize guest preferences for the virtual machine</strong> in the Advanced options pane.</td>
</tr>
<tr>
<td></td>
<td>- The Summary page is displayed if you do not select <strong>Customize guest preferences for the virtual machine</strong> in the Advanced options pane.</td>
</tr>
</tbody>
</table>

Converter Standalone copies the disks to the selected datastores and preserves the source disk layout.

Create an Optimized Partition Layout

By default, Converter Standalone optimizes the disk partitions alignment. Optimizing the partition alignment improves the performance of the destination virtual machine.

Prerequisites

On the Options page of the Conversion wizard, click **Data to copy** in the options list.

Procedure

1. From the **Data copy type** drop-down menu, select **Select volumes to copy**.

2. Select the **Create optimized partition layout** check box.

3. Save your settings.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select another option from the options list</td>
<td>Saves your settings and displays the pane for the selected option.</td>
</tr>
<tr>
<td>Click Next</td>
<td>Saves your settings and displays the next page of the Conversion wizard.</td>
</tr>
<tr>
<td></td>
<td>- The Customizations page is displayed if you select <strong>Customize guest preferences for the virtual machine</strong> in the Advanced options pane.</td>
</tr>
<tr>
<td></td>
<td>- The Summary page is displayed if you do not select <strong>Customize guest preferences for the virtual machine</strong> in the Advanced options pane.</td>
</tr>
</tbody>
</table>

Creating an optimized partition layout aligns the partitions on a 1MB boundary for Windows sources and on a 64KB boundary for Linux sources.
Create a Linked Clone

A linked clone is a VMware virtual machine that shares the virtual disk of the source virtual machine or system image. Linked clones are useful for checking the compatibility of non-VMware images, such as .sv2i and .vmc files.

You can create linked clones only when you convert a virtual machine or other image source to a hosted destination.

You cannot create linked clones from Parallels source images.

You cannot create a linked clone if the source image is password-protected.

**CAUTION** Linked clones converted from Virtual PC and Virtual Server machines, and from LiveState images are corrupted if the source is modified or powered on after the conversion.

**Prerequisites**

Turn off the source virtual machine.

To verify that your source type is a supported third-party source, see “Supported Source Types,” on page 23.

**Procedure**

1. On the Destination System page, select *VMware Workstation or other VMware virtual machine* as a destination and click Next.
2. On the Options page, click *Data to copy* in the left pane.
3. In the *Data copy type* drop-down menu, select *Linked clone*.
4. Save your settings.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select another option from the</td>
<td>Saves your settings and displays the pane for the selected option.</td>
</tr>
<tr>
<td>options list</td>
<td></td>
</tr>
<tr>
<td>Click Next</td>
<td>Saves your settings and displays the next page of the Conversion wizard.</td>
</tr>
<tr>
<td></td>
<td>■ The Customizations page is displayed if you select Customize guest preferences for the virtual machine in the Advanced options pane.</td>
</tr>
<tr>
<td></td>
<td>■ The Summary page is displayed if you do not select Customize guest preferences for the virtual machine in the Advanced options pane.</td>
</tr>
</tbody>
</table>

You have set up a conversion job to create a linked clone.

**Edit the Number of Processor Sockets and Cores**

You can change the number of virtual sockets and the number of processor cores per socket that the destination virtual machine uses.

**Prerequisites**

Make sure the destination host and the guest operating system support the number of processor cores you assign to the destination virtual machine.

**NOTE** You can change the number of processors cores per socket only on ESX/vCenter Server 5.0 and later.

On the Options page of the Conversion wizard, click *Devices* in the options list.

**Procedure**

1. Click the Other tab.
2 From the **Number of virtual sockets** drop-down menu on the CPU Settings panel, select the number of virtual sockets for the destination virtual machine.

3 From the **Number of cores per socket** drop-down menu on the CPU Settings panel, select the number of cores per socket for the destination virtual machine.

4 Save your settings.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select another option from the options list</td>
<td>Saves your settings and displays the pane for the selected option.</td>
</tr>
<tr>
<td>Click Next</td>
<td>Saves your settings and displays the next page of the Conversion wizard.</td>
</tr>
<tr>
<td></td>
<td>■ The Customizations page is displayed if you select <strong>Customize guest</strong></td>
</tr>
<tr>
<td></td>
<td>preferences for the virtual machine in the Advanced options pane.</td>
</tr>
<tr>
<td></td>
<td>■ The Summary page is displayed if you do not select <strong>Customize guest</strong></td>
</tr>
<tr>
<td></td>
<td>preferences for the virtual machine in the Advanced options pane.</td>
</tr>
</tbody>
</table>

The destination virtual machine is configured with the number of virtual processor sockets and cores that you selected. If Converter Standalone shows a message that the destination hardware does not support the number of cores you selected, you must select a supported number of sockets and cores.

**Allocate Memory for the Destination Virtual Machine**

You can change the amount of memory allocated to the destination virtual machine.

By default, Converter Standalone recognizes the amount of memory on the source machine and allocates it to the destination virtual machine.

**Prerequisites**

On the Options page of the Conversion wizard, click **Devices** in the options list.

**Procedure**

1 Click the **Memory** tab.

2 In the Memory panel, use the slider or the spin-box to specify the amount of memory for the destination virtual machine.

3 Save your settings.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select another option from the options list</td>
<td>Saves your settings and displays the pane for the selected option.</td>
</tr>
<tr>
<td>Click Next</td>
<td>Saves your settings and displays the next page of the Conversion wizard.</td>
</tr>
<tr>
<td></td>
<td>■ The Customizations page is displayed if you select <strong>Customize guest</strong></td>
</tr>
<tr>
<td></td>
<td>preferences for the virtual machine in the Advanced options pane.</td>
</tr>
<tr>
<td></td>
<td>■ The Summary page is displayed if you do not select <strong>Customize guest</strong></td>
</tr>
<tr>
<td></td>
<td>preferences for the virtual machine in the Advanced options pane.</td>
</tr>
</tbody>
</table>

Converter Standalone validates the amount of memory. A warning appears if you set the memory amount to more than the maximum supported or to less than the required minimum.
Specify a Disk Controller for the Destination Virtual Machine

You can select a disk controller type for the destination virtual disks.

Prerequisites

On the Options page of the Conversion wizard, click Devices in the options list.

Procedure

1. Click the Other tab.
2. From the Disk controller drop-down menu, select a disk controller for the destination virtual disk.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SCSI Bus Logic</td>
<td>Use SCSI virtual disks in the destination virtual machine.</td>
</tr>
<tr>
<td>IDE</td>
<td>Use IDE virtual disks in the destination virtual machine.</td>
</tr>
<tr>
<td>LSI Logic</td>
<td>Use LSI Logic SCSI virtual disks in the destination virtual machine.</td>
</tr>
<tr>
<td>LSI Logic SAS</td>
<td>Use LSI Logic SCSI (SAS) virtual disks in the destination virtual machine.</td>
</tr>
<tr>
<td>Auto select</td>
<td>Use the same types of disk controllers as those installed on the source machine. If they are not supported on the destination virtual machine, replace them with supported ones. <strong>Note</strong> When converting Linux virtual machines on ESX and vCenter Server earlier than 4.1, the system might not retrieve the full list of supported controllers.</td>
</tr>
</tbody>
</table>

3. Save your settings.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select another option from the options list</td>
<td>Saves your settings and displays the pane for the selected option.</td>
</tr>
<tr>
<td>Click Next</td>
<td>Saves your settings and displays the next page of the Conversion wizard.</td>
</tr>
<tr>
<td></td>
<td>The Customizations page is displayed if you select Customize guest preferences for the virtual machine in the Advanced options pane.</td>
</tr>
<tr>
<td></td>
<td>The Summary page is displayed if you do not select Customize guest preferences for the virtual machine in the Advanced options pane.</td>
</tr>
</tbody>
</table>

Configure the Network Settings of the Destination Virtual Machine

You can change the number of network adapters and select the network that the destination virtual machine uses. You can also set network adapters to connect to the network when the destination virtual machine powers on.

**Note** You cannot use IPv6 to customize the guest operating systems of virtual machines.

Prerequisites

On the Options page of the Conversion wizard, select Networks from the options list.

Procedure

1. From the Network adapters to connect drop-down menu, select the number of network adapters to be used by the destination virtual machine.
2. Use the Network drop-down menu to select the network that the adapter connects to.
3. To connect an adapter when you power on the destination virtual machine, select the Connect at power-on check box.
Configure the Network for the Helper Virtual Machine

When you convert a powered-on Linux machine, Converter Standalone creates a Helper virtual machine on the destination. The Helper virtual machine needs network access to the source machine to clone the source files. Default conversion settings enforce automatic acquisition of an IPv4 address and a DNS server for the Helper virtual machine, but you can set up this network connection manually.

Procedure

1. On the Options page of the Conversion wizard, click **Helper VM network**.
2. (Optional) To assign a static IPv4 address to the Helper virtual machine, select **Use the following IP address** and specify the IPv4 address, subnet mask, and default gateway. Be sure that the IP address you specify for the Helper virtual machine is not already in use on the network.
3. (Optional) Select **Use the following DNS server address** and type the preferred DNS server address to configure the DNS server address manually. Optionally, you can type an alternative DNS server address as well.
4. Save your settings.

Converter Standalone uses the IP address and DNS server you specify to copy data from the source Linux machine to the Helper virtual machine during conversion.

Configure the Software on the Destination Virtual Machine

You can configure the guest operating system so that it is ready to operate in a virtual environment.

Software configuration includes a number of settings.

- **Customize the Windows Guest Operating System** on page 64

  You can customize guest operating systems running Windows XP or later so that the virtual machine is prepared to work immediately in the destination environment.
Install VMware Tools on the Destination Virtual Machine on page 67
When converting Windows source machines, you can install VMware Tools to improve graphics performance of the guest operating system. Other enhancements include automatic grab and release of the mouse pointer, copy and paste operations between guest and host, and improved mouse performance.

Remove System Restore Checkpoints on page 68
When you convert source machines running Windows XP or later, you can remove System Restore checkpoints so that the conversion process is faster.

Customize the Windows Guest Operating System
You can customize guest operating systems running Windows XP or later so that the virtual machine is prepared to work immediately in the destination environment.

Prerequisites
Save the Sysprep files to %ALLUSERSPROFILE%\Application\Data\VMware\VMware vCenter Converter Standalone\sysprep on the machine that runs vCenter Converter server. For more details on the Sysprep files location for different operating systems, see Save Sysprep Files.

On the Options page of the Conversion wizard, click Advanced options, click the Post-conversion tab, and select Customize guest preferences for the virtual machine. Click Next to view and adjust the available customization options.

Customize the Identity of the Destination Virtual Machine on page 64
To configure the identity of the destination virtual machine for the destination network, personalize it by editing its name, owner, and organization name, and by generating a new security ID.

Enter the Windows License Information on page 65
Ensure that you enter licensing information for all destination virtual machines running guest operating systems as necessary.

Set the Time Zone for the Destination Virtual Machine on page 66
You can set the time zone if you are converting a virtual machine to use in a different time zone.

Configure the Network Adapters on page 66
You can configure the network settings of the virtual machine to work with the network configuration of the destination environment.

Assign a Workgroup or Domain Details on page 67
You can set up the workgroup and the domain in which the destination virtual machine belongs.

Customize the Identity of the Destination Virtual Machine
To configure the identity of the destination virtual machine for the destination network, personalize it by editing its name, owner, and organization name, and by generating a new security ID.

Prerequisites
On the Options page of the Conversion wizard, click Advanced options, click the Post-conversion tab, and select Customize guest preferences for the virtual machine. Click Next to view and adjust the available customization options.

Procedure
1. On the Customizations page, select Computer information from the options list.
2 Customize the guest operating system identity.
   a In the **Computer Name** text box, specify a computer name to identify the virtual machine on the
      network.
      Valid characters include A-Z, a-z, 0-9, and the hyphen (-). The underscore (_) is nonstandard, but
      Converter Standalone permits it. The recommended length for most languages is 15 characters or less.
      Computer names cannot consist only of numerals.
   b In the **Owner Name** text box, write the name of the owner of the virtual machine.
      Valid characters include A-Z, a-z, 0-9, and the hyphen (-). The underscore (_) is nonstandard, but
      Converter Standalone permits it. The owner name cannot have more than 63 characters or consist
      only of numerals.
   c In the **Organization** field, enter an organization name.
      Valid characters include all printable characters. The limit is 63 characters.
3 (Optional) To create a new security identifier, select **Generate New Security ID (SID)**.
   By default, the security ID is selected for source systems that run Windows Vista or later and cannot be
deselected.

The identifiers of the destination virtual machine are assigned according to your settings.

**What to do next**

You can select another option to set or click **Next** to view a summary of the conversion job. If the **Next** button
is inactive, check the Current settings list for other settings that need your attention on this page.

**Enter the Windows License Information**

Ensure that you enter licensing information for all destination virtual machines running guest operating
systems as necessary.

**Prerequisites**

On the Options page of the Conversion wizard, click **Advanced options**, click the **Post-conversion** tab, and
select **Customize guest preferences for the virtual machine**. Click **Next** to view and adjust the available
customization options.

**Procedure**

1 On the Customizations page, select **Windows license** from the options list.
2 Type **Product ID** information for the destination virtual machine.
3 (Optional) Select **Include server license information** if the guest operating system is Windows Server
4 Select a **Server license mode** option.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Per seat</strong></td>
<td>For individual user licenses.</td>
</tr>
<tr>
<td><strong>Per server</strong></td>
<td>For a concurrent user license. Specify the <strong>Maximum connections</strong> value when you select this option.</td>
</tr>
</tbody>
</table>

The Windows license information is saved to the destination virtual machine after the conversion.
What to do next
You can select another option to set or click Next to view a summary of the conversion job. If the Next button is inactive, check the Current settings list for other settings that need your attention on this page.

Set the Time Zone for the Destination Virtual Machine
You can set the time zone if you are converting a virtual machine to use in a different time zone.

Prerequisites
On the Options page of the Conversion wizard, click Advanced options, click the Post-conversion tab, and select Customize guest preferences for the virtual machine. Click Next to view and adjust the available customization options.

Procedure
1. On the Customizations page, select Time zone from the options list.
2. Select the target time zone from the Time zone drop-down menu.

The time zone is set on the destination virtual machine after the conversion.

What to do next
You can select another option to set or click Next to view a summary of the conversion job. If the Next button is inactive, check the Current settings list for other settings that need your attention on this page.

Configure the Network Adapters
You can configure the network settings of the virtual machine to work with the network configuration of the destination environment.

The option for configuring network adapters is available for all supported destinations.

**NOTE** You cannot use IPv6 to customize the guest operating systems of virtual machines.

Prerequisites
On the Options page of the Conversion wizard, click Advanced options, click the Post-conversion tab, and select Customize guest preferences for the virtual machine. Click Next to view and adjust the available customization options.

Procedure
1. On the Customizations page, select Network interface settings from the options list.
2. Select a network adapter and click Customize to configure its properties.
   a. On the General tab, type the IPv4 address and DNS server address.
   b. On the DNS tab, specify the DNS connections by entering DNS suffixes.
   c. Enter a DNS suffix and click Add.
      You can add more than one DNS suffix.
   d. If you are specifying multiple DNS suffixes, use Move up and Move down to specify the order in which the guest operating system uses the connections.
   e. On the WINS tab, type the primary and secondary WINS IP address in the text box.

When powered on, the destination virtual machine uses the network settings that you configured.
What to do next
You can select another option to set or click Next to view a summary of the conversion job. If the Next button is inactive, check the Current settings list for other settings that need your attention on this page.

Assign a Workgroup or Domain Details
You can set up the workgroup and the domain in which the destination virtual machine belongs.

Prerequisites
On the Options page of the Conversion wizard, click Advanced options, click the Post-conversion tab, and select Customize guest preferences for the virtual machine. Click Next to view and adjust the available customization options.

Procedure
1. On the Customizations page, select Workgroup/Domain from the options list.
2. Select how the virtual machine participates in the destination network.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Workgroup</td>
<td>Valid characters include A-Z, a-z, 0-9, space, and the hyphen (-). Maximum length is 15 characters.</td>
</tr>
<tr>
<td>Windows server domain</td>
<td>The text box must have a value. Valid characters include A-Z, a-z, 0-9, space, period, and hyphen (-). The entire text string can be up to 64 characters. User credentials are required.</td>
</tr>
</tbody>
</table>

The destination virtual machine connects to the specified workgroup and domain server.

What to do next
You can select another option to set or click Next to view a summary of the conversion job. If the Next button is inactive, check the Current settings list for other settings that need your attention on this page.

Install VMware Tools on the Destination Virtual Machine
When converting Windows source machines, you can install VMware Tools to improve graphics performance of the guest operating system. Other enhancements include automatic grab and release of the mouse pointer, copy and paste operations between guest and host, and improved mouse performance.

Prerequisites
On the Options page of the Conversion wizard, click Advanced options in the options list.

Procedure
1. Click the Post-conversion tab.
2. In the Post-conversion processing section, select the Install VMware Tools on the destination virtual machine check box.
3 Save your settings.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select another option from the options list</td>
<td>Saves your settings and displays the pane for the selected option.</td>
</tr>
<tr>
<td>Click Next</td>
<td>Saves your settings and displays the next page of the Conversion wizard.</td>
</tr>
<tr>
<td></td>
<td>■ The Customizations page is displayed if you select <strong>Customize guest preferences for the virtual machine</strong> in the Advanced options pane.</td>
</tr>
<tr>
<td></td>
<td>■ The Summary page is displayed if you do not select <strong>Customize guest preferences for the virtual machine</strong> in the Advanced options pane.</td>
</tr>
</tbody>
</table>

Converter Standalone installs VMware Tools on the destination machine when the destination machine is powered on for the first time after the conversion job.

**Remove System Restore Checkpoints**

When you convert source machines running Windows XP or later, you can remove System Restore checkpoints so that the conversion process is faster.

System Restore is enabled on Windows Vista and Windows XP systems by default. For Windows Vista, if you are performing volume-based file-level cloning, System Restore checkpoints are removed automatically from the destination virtual machine, regardless of whether the **Remove System Restore checkpoints on destination** check box is selected or deselected. If you are performing disk-based cloning or volume-based block-level cloning, deselecting the check box instructs Converter Standalone to keep the System Restore checkpoints in the destination virtual machine.

Removing System Restore checkpoints prevents the target machine from reverting to a preconversion state. In the target virtual machine, restoring a checkpoint that was created before you cloned the source machine can damage the system and prevent the destination virtual machine from starting up.

**Prerequisites**

On the Options page of the Conversion wizard, click **Advanced options** in the options list.

**Procedure**

1 Click the **Post-conversion** tab.

2 In the Post-conversion processing section, select the **Remove System Restore checkpoints on destination** check box.

3 Save your settings.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select another option from the options list</td>
<td>Saves your settings and displays the pane for the selected option.</td>
</tr>
<tr>
<td>Click Next</td>
<td>Saves your settings and displays the next page of the Conversion wizard.</td>
</tr>
<tr>
<td></td>
<td>■ The Customizations page is displayed if you select <strong>Customize guest preferences for the virtual machine</strong> in the Advanced options pane.</td>
</tr>
<tr>
<td></td>
<td>■ The Summary page is displayed if you do not select <strong>Customize guest preferences for the virtual machine</strong> in the Advanced options pane.</td>
</tr>
</tbody>
</table>
Configure the Conversion Job

You can configure the conversion process and select the behavior of the source and destination machine during and after conversion. You can change the status of the source and destination services only when the source machine is running a Windows operating system.

- **Set the Startup Mode for Destination Services** on page 69
  To minimize downtime for a Windows service, you can select the service and have it start automatically on the destination virtual machine. You can also prevent Windows services from automatically starting on the destination machine.

- **Stop Services Running on the Source Machine** on page 70
  You can make sure that you do not lose data from services running on the source machine. You can select the services that you want to stop before Converter Standalone synchronizes the data between the source and destination machine. As a result, the services do not generate data while source and destination machines are synchronized.

- **Synchronize the Destination Machine with Changes Made to the Source Machine** on page 71
  When you convert a powered-on Windows machine, Converter Standalone copies data from the source machine to the destination machine while the source machine is still running and generating changes. This process is the first transfer of data. You can transfer data for the second time by copying only the changes made during the first transfer of data. This process is called synchronization.

- **Power Off the Source Machine After Conversion** on page 72
  If your source machine is running services that you want to start on the destination virtual machine after conversion, you can power off the source machine to avoid interference between source and destination services.

- **Power On the Destination Virtual Machine After Conversion** on page 72
  You can minimize the downtime of important services by powering on the destination virtual machine immediately after the conversion is complete.

- **Limit the Amount of Resources Used by the Conversion Job** on page 73
  A conversion job competes for computing resources with other processes. To limit the impact of the conversion job on other workloads, you can throttle the job. If you do not throttle conversion jobs, they are carried out with normal priority and depending on the available computing resources during conversion.

- **Uninstall Converter Standalone Agent from the Source Machine** on page 73
  When setting up a conversion job for a powered-on Windows source or a Hyper-V Server virtual machine, you can choose how you want to remove the Converter Standalone agent from the source after the conversion. If the Converter Standalone agent is installed by the Converter Standalone server, it is uninstalled automatically. Otherwise, you must uninstall it manually.

**Set the Startup Mode for Destination Services**

To minimize downtime for a Windows service, you can select the service and have it start automatically on the destination virtual machine. You can also prevent Windows services from automatically starting on the destination machine.

You can change the settings for the destination services only when you convert source machines that run Windows.

**Prerequisites**

On the Options page of the Conversion wizard, click **Services** in the options list.
Procedure

1 If you are converting a powered-on source machine, click the **Destination services** tab.
   
   If the source machine is powered off, the Services pane displays no tabs. You can modify only the starting mode of destination services.

2 On the services list, select the startup mode for each service.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automatic</td>
<td>The service starts automatically after the destination machine is powered on.</td>
</tr>
<tr>
<td>Manual</td>
<td>The service does not start after the destination machine is powered on, but you can start it manually.</td>
</tr>
<tr>
<td>Disabled</td>
<td>The service is disabled and does not start after the destination machine is powered on.</td>
</tr>
</tbody>
</table>

3 Save your settings.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select another option from the options list</td>
<td>Saves your settings and displays the pane for the selected option.</td>
</tr>
<tr>
<td>Click Next</td>
<td>Saves your settings and displays the next page of the Conversion wizard.</td>
</tr>
<tr>
<td></td>
<td>- The Customizations page is displayed if you select <strong>Customize guest preferences for the virtual machine</strong> in the Advanced options pane.</td>
</tr>
<tr>
<td></td>
<td>- The Summary page is displayed if you do not select <strong>Customize guest preferences for the virtual machine</strong> in the Advanced options pane.</td>
</tr>
</tbody>
</table>

Stop Services Running on the Source Machine

You can make sure that you do not lose data from services running on the source machine. You can select the services that you want to stop before Converter Standalone synchronizes the data between the source and destination machine. As a result, the services do not generate data while source and destination machines are synchronized.

You can stop services on the source only when you convert a powered-on Windows machine.

Prerequisites

On the Options page of the Conversion wizard, click **Services** in the options list.

Procedure

1 Click the **Source services** tab.

2 To stop a service on the source machine before synchronization, highlight a service and select the **Stop** check box to the right.

3 Save your settings.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select another option from the options list</td>
<td>Saves your settings and displays the pane for the selected option.</td>
</tr>
<tr>
<td>Click Next</td>
<td>Saves your settings and displays the next page of the Conversion wizard.</td>
</tr>
<tr>
<td></td>
<td>- The Customizations page is displayed if you select <strong>Customize guest preferences for the virtual machine</strong> in the Advanced options pane.</td>
</tr>
<tr>
<td></td>
<td>- The Summary page is displayed if you do not select <strong>Customize guest preferences for the virtual machine</strong> in the Advanced options pane.</td>
</tr>
</tbody>
</table>
Converter Standalone stops the selected source services before it synchronizes the destination machine with the source machine.

**Synchronize the Destination Machine with Changes Made to the Source Machine**

When you convert a powered-on Windows machine, Converter Standalone copies data from the source machine to the destination machine while the source machine is still running and generating changes. This process is the first transfer of data. You can transfer data for the second time by copying only the changes made during the first transfer of data. This process is called synchronization.

Synchronization is available only for Windows XP or later source operating systems.

If you resize FAT volumes or shrink NTFS volumes, or change the cluster size on the destination volume, you cannot use the synchronization option.

You cannot add or remove volumes on the source machine between two cloning tasks of a synchronizable job because it might cause conversion to fail.

**Prerequisites**

Stop various source services to make sure they do not generate additional changes during the synchronization, as that might lead to data loss.

On the Options page of the Conversion wizard, click Advanced options in the options list.

**Procedure**

1. Click the Synchronize tab.
2. Select Synchronize changes.
3. Specify when you want to perform the synchronization.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select the Run immediately after cloning check box</td>
<td>Synchronization is performed immediately after the cloning is complete.</td>
</tr>
<tr>
<td>Select the Schedule check box</td>
<td>Synchronization is performed at the scheduled time and date. Use the Run at text box to specify the start date and time for the synchronization.</td>
</tr>
</tbody>
</table>

4. Select Perform final synchronization if you do not plan to make further synchronizations between the source and the destination.
5. Save your settings.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select another option from the options list</td>
<td>Saves your settings and displays the pane for the selected option.</td>
</tr>
<tr>
<td>Click Next</td>
<td>Saves your settings and displays the next page of the Conversion wizard.</td>
</tr>
<tr>
<td></td>
<td>The Customizations page is displayed if you select Customize guest preferences for the virtual machine in the Advanced options pane.</td>
</tr>
<tr>
<td></td>
<td>The Summary page is displayed if you do not select Customize guest preferences for the virtual machine in the Advanced options pane.</td>
</tr>
</tbody>
</table>
Power Off the Source Machine After Conversion

If your source machine is running services that you want to start on the destination virtual machine after conversion, you can power off the source machine to avoid interference between source and destination services.

Prerequisites

On the Options page of the Conversion wizard, click Advanced options in the options list.

Procedure

1. Click the Post-conversion tab.
2. In the Post-conversion power state panel, select Power off source machine.
3. Save your settings.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select another option from the options list</td>
<td>Saves your settings and displays the pane for the selected option.</td>
</tr>
<tr>
<td>Click Next</td>
<td>Saves your settings and displays the next page of the Conversion wizard.</td>
</tr>
<tr>
<td></td>
<td>- The Customizations page is displayed if you select Customize guest preferences for the virtual machine in the Advanced options pane.</td>
</tr>
<tr>
<td></td>
<td>- The Summary page is displayed if you do not select Customize guest preferences for the virtual machine in the Advanced options pane.</td>
</tr>
</tbody>
</table>

Converter Standalone powers off the source machine after the conversion is complete.

Power On the Destination Virtual Machine After Conversion

You can minimize the downtime of important services by powering on the destination virtual machine immediately after the conversion is complete.

Prerequisites

On the Options page of the Conversion wizard, click Advanced options in the options list.

Procedure

1. Click the Post-conversion tab.
2. In the Post-conversion power state panel, select Power on destination machine.
3. Save your settings.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select another option from the options list</td>
<td>Saves your settings and displays the next page of the Conversion wizard.</td>
</tr>
<tr>
<td>Click Next</td>
<td>Saves your settings and displays the next page of the Conversion wizard.</td>
</tr>
<tr>
<td></td>
<td>- The Customizations page is displayed if you select Customize guest preferences for the virtual machine in the Advanced options pane.</td>
</tr>
<tr>
<td></td>
<td>- The Summary page is displayed if you do not select Customize guest preferences for the virtual machine in the Advanced options pane.</td>
</tr>
</tbody>
</table>

After the conversion, Converter Standalone powers on the destination machine.
Limit the Amount of Resources Used by the Conversion Job

A conversion job competes for computing resources with other processes. To limit the impact of the conversion job on other workloads, you can throttle the job. If you do not throttle conversion jobs, they are carried out with normal priority and depending on the available computing resources during conversion.

A powered-on source machine runs its own conversion job. You can limit the impact of the conversion job on other workloads running on the powered-on machine.

For source machines that are not powered on, you can limit the resources used on the machine where Converter Standalone server is installed.

Throttling controls the CPU and network resources that the conversion process uses. You cannot throttle disk I/O from the Converter Standalone interface, but can throttle it indirectly by throttling the network bandwidth.

**NOTE** You cannot throttle conversion jobs for powered-on source machines that run Linux.

**Procedure**

1. On the Options page, select Throttling from the options list.
2. From the CPU throttling drop-down menu, select the priority of the conversion task.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>The priority of the current conversion task is set to normal.</td>
</tr>
<tr>
<td>Light</td>
<td>The priority of the current conversion task is reduced slightly below normal.</td>
</tr>
<tr>
<td>Medium</td>
<td>The priority of the current conversion task is set to lowest.</td>
</tr>
</tbody>
</table>

**NOTE** Converter Standalone reduces the thread priorities of conversion tasks to control the CPU resources they consume.

3. (Optional) Select Network bandwidth throttling and specify the maximum network bandwidth at which Converter Standalone performs the conversion jobs.
4. Save your settings.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select another option from the options list</td>
<td>Saves your settings and displays the pane for the selected option.</td>
</tr>
<tr>
<td>Click Next</td>
<td>Saves your settings and displays the next page of the Conversion wizard.</td>
</tr>
<tr>
<td></td>
<td>The Customizations page is displayed if you select Customize guest preferences for the virtual machine in the Advanced options pane.</td>
</tr>
<tr>
<td></td>
<td>The Summary page is displayed if you do not select Customize guest preferences for the virtual machine in the Advanced options pane.</td>
</tr>
</tbody>
</table>

Uninstall Converter Standalone Agent from the Source Machine

When setting up a conversion job for a powered-on Windows source or a Hyper-V Server virtual machine, you can choose how you want to remove the Converter Standalone agent from the source after the conversion. If the Converter Standalone agent is installed by the Converter Standalone server, it is uninstalled automatically. Otherwise, you must uninstall it manually.

Use Add or Remove Programs on the source machine to uninstall the Converter Standalone agent.

**Procedure**

1. In Windows, run Add or Remove Programs.
2 In the list of installed programs, locate and click **VMware vCenter Converter Standalone Agent**.

3 Click **Remove**.

4 In the confirmation dialog box, click **Yes**.

Windows installer uninstalls the Converter Standalone agent from the source machine.

**Review the Summary and Submit the Conversion Job**

On the Summary page, you can view a summary of the conversion job before you add it to the job list. The summary includes information about the source machine, the destination virtual machine, and destination customization settings (if any). Converter Standalone performs job validation at this stage.

**Prerequisites**

You must complete all steps in the Conversion wizard to access the Summary page.

**Procedure**

1 Review the summary of the job.

2 Click **Finish** to submit the job.

Converter Standalone validates the job parameters. This might take several minutes. If the validation succeeds, the conversion job appears in the Job View list in the main application window. You can find information about the tasks of the job in the Task View. If the validation fails, you must click **Back** and correct the invalid parameters as prompted.
Configure Virtual Machines

You might need to configure a virtual machine after you convert it so that it is ready to start in the destination virtual environment. You might also need to configure virtual machines if their virtual environment changes or if you need to improve their performance.

**NOTE** You can configure only virtual machines that run Windows XP or later. You cannot configure virtual machines that run operating systems other than Windows.

Unlike the conversion process, which is nondestructive to the source machine, the configuration process affects the source. When you create a configuration job, your settings are applied to the configuration source machine and cannot be reverted.

**Procedure**

1. **Save Sysprep Files** on page 75
   To customize the guest operating system of a virtual machine that runs Windows Server 2003 or Windows XP, you must save the Sysprep files to the specified locations on the machine where Converter Standalone server runs.

2. **Start the Configuration Wizard** on page 76
   You can configure VMware desktop virtual machines or virtual machines managed by ESX hosts or vCenter Server.

3. **Select a Source Machine to Configure** on page 76
   You can select a powered-off VMware virtual machine as the source for a configuration task.

4. **Select the Options to Configure** on page 79
   When you create a configuration job, you can select the steps of the configuration process that you want to run.

5. **Review and Submit the Configuration Job** on page 83
   After you review your settings on the Summary page of the Configuration wizard, you can go back and change a setting or submit the job.

**Save Sysprep Files**

To customize the guest operating system of a virtual machine that runs Windows Server 2003 or Windows XP, you must save the Sysprep files to the specified locations on the machine where Converter Standalone server runs.

**Prerequisites**

You must download the Sysprep files that correspond to the operating system of the source machine.
Procedure

- Save the Sysprep files that correspond to the source operating system to the specified location on the machine where Converter Standalone server runs.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows Server 2003 (32bit)</td>
<td>The Sysprep files Location for Windows: %ALLUSERSPROFILE%\Application Data\VMware\VMware vCenter Converter Standalone\sysprep\svr2003</td>
</tr>
<tr>
<td>Windows Server 2003 (64bit)</td>
<td>The Sysprep files Location for Windows: %ALLUSERSPROFILE%\Application Data\VMware\VMware vCenter Converter Standalone\sysprep\svr2003-64</td>
</tr>
<tr>
<td>Windows XP (32bit)</td>
<td>The Sysprep files Location for Windows: %ALLUSERSPROFILE%\Application Data\VMware\VMware vCenter Converter Standalone\sysprep\xp</td>
</tr>
<tr>
<td>Windows XP (64bit)</td>
<td>The Sysprep files Location for Windows: %ALLUSERSPROFILE%\Application Data\VMware\VMware vCenter Converter Standalone\sysprep\xp-64</td>
</tr>
</tbody>
</table>

You can now customize Windows Server 2003 (32bit and 64bit) and Windows XP (32bit and 64bit) guest operating systems by using the Conversion or the Configuration wizard.

What to do next

You can now use the Configuration wizard to customize Windows guest operating systems.

Start the Configuration Wizard

You can configure VMware desktop virtual machines or virtual machines managed by ESX hosts or vCenter Server.

A physical machine cannot be a configuration source.

You can configure only powered-off virtual machines.

Procedure

1. Start the VMware vCenter Converter Standalone application.
2. Click Configure Machine in the application menu.
   The Configuration wizard opens.

What to do next

Select the source machine to configure.

Select a Source Machine to Configure

You can select a powered-off VMware virtual machine as the source for a configuration task.

Prerequisites

On the Source System page of the Configuration wizard, select a source type from the drop-down menu.

What to do next

On the Options page of the Configuration wizard, you can select the required configuration options.
Select a VMware Infrastructure Virtual Machine to Configure

If the system you want to configure is a virtual machine that runs on an ESX host or on an ESX host managed by vCenter Server, you must select a VMware Infrastructure virtual machine as the source type.

**Prerequisites**

Power off the source machine before the configuration.

In the main application window of Converter Standalone, click **Configure Machine** to open the Configuration wizard.

**Procedure**

1. On the Source System page of the Configuration wizard, select **VMware Infrastructure virtual machine** from the **Select source type** drop-down menu.

2. Provide the IP address or host name and credentials for authentication with the ESX host or the vCenter Server, and click **Next**.

The Source Machine page appears, displaying the host name or IP address and the inventory of the ESX host or the vCenter Server.

**What to do next**

On the Source Machine page of the Configuration wizard you can browse the virtual infrastructure inventory and select the virtual machine to configure.

Specify the vCenter Server Virtual Machine to Configure

If you choose to configure a virtual machine managed by a vCenter Server or ESX host, you must browse the inventory to locate the source virtual machine.

**Prerequisites**

On the Source System page of the Configuration wizard, select **VMware Infrastructure virtual machine** as the configuration source and click **Next** to proceed to the Source Machine page.

**Procedure**

1. (Optional) If you are connected to a vCenter Server, select a virtual machine view from the **Specify machine with** drop-down menu.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hosts and Clusters</td>
<td>The Inventory tree pane provides a view of hosts, clusters, resource pools, and vApps. If you select a host managed by a cluster, you see the full list of virtual machines and templates in the VM list view. If you select a standalone host or a cluster, you see only the virtual machines that are not deployed in the resource pools of that host or cluster.</td>
</tr>
<tr>
<td>VMs and Templates</td>
<td>The Inventory tree pane provides a view of datacenters and VM folders.</td>
</tr>
</tbody>
</table>

2. (Optional) If you are connected to a vCenter Server, select an object from the Inventory tree pane.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hosts and Clusters</td>
<td>Select cluster, ESX host, resource pool, or vApp.</td>
</tr>
<tr>
<td>VMs and Templates</td>
<td>Select datacenter or VM folder.</td>
</tr>
</tbody>
</table>
3 From the virtual machines list, select the virtual machine you want to configure.

You can search for virtual machines in the VM list by typing one or more letters of their names in the Search for name with text box. You can clear your search by clicking Clear.

**NOTE** If you connect to a vCenter Server that has a disconnected ESX instance (powered off, connected to another vCenter Server, or in maintenance mode), you cannot select a virtual machine from that ESX host.

4 (Optional) To refresh the Inventory, click Refresh.

5 (Optional) To view more details about a machine, select it and click View source details.

6 Click Next to proceed to the Options page.

**What to do next**

On the Options page of the Configuration wizard, you can select the required configuration options.

---

**Select a VMware Desktop Virtual Machine to Configure**

If the system you want to configure is a standalone VMware virtual machine created with VMware Workstation, VMware Fusion, VMware Player, VMware Server, or VMware ACE, you must select VMware Workstation or other VMware virtual machine as the configuration source type.

**Prerequisites**

If you plan to use a network path to locate the source, verify that the machine where Converter Standalone server runs has access to that network path.

In the main application window of Converter Standalone, click Configure Machine to open the Configuration wizard.

**Procedure**

1 On the Source System page of the Configuration wizard, select VMware Workstation or other VMware virtual machine.

2 Locate the virtual machine source.

   - If you are connected to a remote Converter Standalone server, provide a network path to the source virtual machine file (.vmx) in the Virtual machine file text box. For example, \server\virtual_machines\virtual_machine.vmx.
   
   - If you are connected to a local Converter Standalone server, provide a network path or a local path to the .vmx file.

   The file type choices are limited to VMware Workstation *.vmx files.

3 If you are connected to a remote Converter Standalone server, enter user credentials for accessing the source virtual machine.

   You do not have to provide user credentials if you are connected to a local Converter Standalone server. In such cases, Converter Standalone uses the Windows credentials to connect to the source machine.

4 (Optional) To view more information about the selected source, click View source details.

5 Click Next to proceed to the Options page.

**What to do next**

On the Options page of the Configuration wizard, you can select the required configuration options.
Select the Options to Configure

When you create a configuration job, you can select the steps of the configuration process that you want to run.

**Procedure**

- On the Options page, select one or more configuration steps to perform and click Next.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Install VMware Tools on the destination virtual machine</td>
<td>Installs VMware Tools to enhance the performance of the destination virtual machine.</td>
</tr>
<tr>
<td>Customize guest preferences for the virtual machine</td>
<td>Allows you to customize Windows XP or later guest operating systems so that the virtual machine is prepared to work in the destination environment.</td>
</tr>
<tr>
<td>Remove System Restore checkpoints on destination</td>
<td>Removes System Restore checkpoints from the destination virtual machine.</td>
</tr>
<tr>
<td>Reconfigure destination virtual machine</td>
<td>Updates the drivers on the virtual machine so that it is bootable in a virtual environment.</td>
</tr>
</tbody>
</table>

**What to do next**

On the basis of the configuration options you selected, you can either customize the guest operating system of the source virtual machine or view the Summary page of the Configuration wizard.

**Install VMware Tools on a Virtual Machine**

Install VMware Tools to improve graphics performance for the guest operating system of a configured virtual machine. Other enhancements include automatic grab and release of the mouse pointer, copying and pasting between guest and host, improved mouse performance, and so on.

Install VMware Tools on the virtual machine you are configuring.

**Procedure**

- On the Options page of the Configuration wizard, select **Install VMware Tools on the destination virtual machine** and click Next.

vCenter Converter Standalone installs VMware Tools on the configured virtual machine.

**What to do next**

Depending on the configuration options you selected, you can either customize the guest operating system or view the Summary page of the Configuration wizard.

**Customize the Windows Guest Operating System**

As a part of the configuration job, you can customize virtual machines running Windows XP or later.

**Prerequisites**

Save the Sysprep files to `%ALLUSERSPROFILE%\Application Data\VMware\VMware vCenter Converter Standalone\sysprep` on the machine that runs vCenter Converter server. For more details on the Sysprep files location for different operating systems, see Save Sysprep Files.

On the Options page of the Configuration wizard, select **Customize guest preferences for the virtual machine** and click Next to view and adjust the available customization options.
Customize the Identity of a Virtual Machine

To configure the identity of a virtual machine on a virtual network, personalize the virtual machine by editing its name, owner, and organization name, and by generating a new security ID.

**Prerequisites**

On the Options page of the Configuration wizard, select **Customize guest preferences for the virtual machine** and click **Next** to view and adjust the available customization options.

**Procedure**

1. On the Customizations page, select **Computer information** from the options list.
2. Customize the guest operating system identity.
   a. In the **Computer Name** text box, specify a computer name to identify the virtual machine on the network.
      
      Valid characters include A-Z, a-z, 0-9, and the hyphen (-). The underscore (_) is nonstandard, but Converter Standalone permits it. The recommended length for most languages is 15 characters or less. Computer names cannot consist only of numerals.
   b. In the **Owner Name** text box, write the name of the owner of the virtual machine.
      
      Valid characters include A-Z, a-z, 0-9, and the hyphen (-). The underscore (_) is nonstandard, but Converter Standalone permits it. The owner name cannot have more than 63 characters or consist only of numerals.
   c. In the **Organization** field, enter an organization name.
      
      Valid characters include all printable characters. The limit is 63 characters.
3. (Optional) To create a new security identifier, select **Generate New Security ID (SID)**.
   
   By default, the security ID is selected for source systems that run Windows Vista or later and cannot be deselected.

The identifiers of the configured virtual machine are assigned according to your settings.

**What to do next**

You can select another option to set or click **Next** to view a summary of the configuration job. If the **Next** button is inactive, check the Current settings list for other settings that need your attention on this page.
Specify the Windows License Information

Ensure that you enter licensing information for all destination virtual machines running guest operating systems as necessary.

Prerequisites

On the Options page of the Configuration wizard, select Customize guest preferences for the virtual machine and click Next to view and adjust the available customization options.

Procedure

1. On the Customizations page, select Windows license from the options list.
2. Type Product ID information for the destination virtual machine.
3. (Optional) Select Include server license information if the guest operating system is Windows Server 2003 or Windows Server 2008.
4. Select a Server license mode option.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Per seat</td>
<td>For individual user licenses.</td>
</tr>
<tr>
<td>Per server</td>
<td>For a concurrent user license. Specify the Maximum connections value when you select this option.</td>
</tr>
</tbody>
</table>

The Windows license information is saved to the configuration source machine when the configuration task is completed.

What to do next

You can select another option to set or click Next to view a summary of the configuration job. If the Next button is inactive, check the Current settings list for other settings that need your attention on this page.

Set the Time Zone

You can configure the time zone for a virtual machine.

Prerequisites

On the Options page of the Configuration wizard, select Customize guest preferences for the virtual machine and click Next to view and adjust the available customization options.

Procedure

1. On the Customizations page, select Time zone from the options list.
2. Select the target time zone from the Time zone drop-down menu.

The time zone is set on the destination machine when the configuration job completes.

What to do next

You can select another option to set or click Next to view a summary of the configuration job. If the Next button is inactive, check the Current settings list for other settings that need your attention on this page.
Configure the Network Adapters

You can change the network settings of a virtual machine to work with the network configuration of the virtual environment.

The options for configuring network adapters are available for all supported customization sources.

Prerequisites

On the Options page of the Configuration wizard, select Customize guest preferences for the virtual machine and click Next to view and adjust the available customization options.

Procedure

1. On the Customizations page, select Network interface settings from the options list.
2. Select a network adapter and click Customize to configure its properties.
   a. On the General tab, type the IPv4 address and DNS server address.
   b. On the DNS tab, specify the DNS connections by entering DNS suffixes.
   c. Enter a DNS suffix and click Add.
      You can add more than one DNS suffix.
   d. If you are specifying multiple DNS suffixes, use Move up and Move down to specify the order in which the guest operating system uses the connections.
   e. On the WINS tab, type the primary and secondary WINS IP address in the text box.

When powered on, the configured virtual machine uses the network settings that you specified.

What to do next

You can select another option to set or click Next to view a summary of the configuration job. If the Next button is inactive, check the Current settings list for other settings that need your attention on this page.

Assign a Workgroup or Domain Details

You can configure the workgroup and the domain for a virtual machine.

Prerequisites

On the Options page of the Configuration wizard, select Customize guest preferences for the virtual machine and click Next to view and adjust the available customization options.

Procedure

1. On the Customizations page, select Workgroup/Domain from the options list.
2. Select how the virtual machine participates in the destination network.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Workgroup</td>
<td>Valid characters include A-Z, a-z, 0-9, space, and the hyphen (-). Maximum length is 15 characters.</td>
</tr>
<tr>
<td>Windows server domain</td>
<td>The text box must have a value. Valid characters include A-Z, a-z, 0-9, space, period, and hyphen (-). The entire text string can be up to 64 characters. User credentials are required.</td>
</tr>
</tbody>
</table>

The configured virtual machine connects to the specified workgroup and domain server.
What to do next

You can select another option to set or click Next to view a summary of the configuration job. If the Next button is inactive, check the Current settings list for other settings that need your attention on this page.

Remove System Restore Checkpoints

Remove the System Restore checkpoints of newly imported source machines to prevent them from reverting to a preconversion state. For other configuration source machines, removing System Restore checkpoints helps you save disk space by deleting unnecessary data.

Procedure

- On the Options page of the Configuration wizard, select Remove System Restore checkpoints on the destination and click Next.

The System Restore checkpoints are deleted from the configuration source machine.

What to do next

Depending on the configuration options you selected, you can either customize the guest operating system or view the Summary page of the Configuration wizard.

Update the Device Drivers of a Virtual Machine

If a newly converted virtual machine does not start properly in the destination virtual environment, try configuring it to update its device drivers.

Procedure

- On the Options page of the Configuration wizard, select Reconfigure destination virtual machine and click Next.

Converter Standalone updates the device drivers on the source machine so it can work in the virtual environment.

What to do next

Depending on the configuration options you selected, you can either customize the guest operating system or view the Summary page of the Configuration wizard.

Review and Submit the Configuration Job

After you review your settings on the Summary page of the Configuration wizard, you can go back and change a setting or submit the job.

Procedure

1. Review the summary of the settings for the source virtual machine.
2. Click Finish to submit the configuration job.

The job appears in the jobs list in the Job View list of the main application window. You can view the progress of the current task on the Task progress tab in Task View.

What to do next

To view details about the configuration task, click the Summary tab.
Manage Conversion and Configuration Jobs and Tasks

Converter Standalone provides a manager for managing conversion and configuration jobs and tasks.

After you create a conversion or configuration job by using the Converter Standalone wizards, you can use the Task View and the Job View of the Converter Standalone manager to monitor and manage the existing jobs and their tasks.

Scheduled synchronized conversion jobs can contain multiple tasks.

This chapter includes the following topics:

- “Manage Jobs in the Job List,” on page 85
- “Manage Tasks in the Task List,” on page 89
- “Verify Jobs and Tasks Progress and the Log Files,” on page 91

Manage Jobs in the Job List

The Job View of the Converter Standalone manager provides a list of all jobs that are submitted. You can use the main application menus to control the way jobs appear in the job list and to edit them.

Prerequisites

You must submit a conversion or configuration job to view it in the job list.

You must be in the Job View of the Converter Standalone manager to access the application menus for job managing.

- **Add a Job to the Job List** on page 86
  Converter Standalone allows you to create and run conversion and configuration jobs.

- **View the Running Task of a Job** on page 86
  You can switch from Job View to Task View to view and edit the currently running task of a job.

- **Deactivate a Job** on page 86
  You can deactivate an active job without applying any changes to the destination machine.

- **Delete a Job** on page 87
  You can delete a job and all its tasks.

- **Create a Job by Copying an Existing Job** on page 87
  You can create a new job by creating a copy of an existing job and modifying its settings in the Conversion or the Configuration wizard. The settings for the original job appear at each step of the wizard so that you can reuse or change them.
Filter the Jobs in the Jobs List on page 87
You can select the jobs that you want the job list to display by filtering them.

Add a Synchronization Task to a Conversion Job on page 88
You can add a synchronization task to an active conversion job and modify the synchronization settings in the Conversion wizard.

Add a Job to the Job List
Converter Standalone allows you to create and run conversion and configuration jobs.

Procedure
◆ On the Summary page of the Conversion or the Configuration wizard, make sure no settings need adjustment, and click Finish to add a conversion or configuration job.

The job appears at the beginning of the job list in the Job View and its tasks appear in the Task View.

What to do next
In the job list, you can view the job status, which task of the job is currently running, and other details. You can also delete a job, and perform other job operations.

View the Running Task of a Job
You can switch from Job View to Task View to view and edit the currently running task of a job.

Procedure
1 From the View by drop-down menu on the toolbar, select Jobs.
2 From the job list, select a job.
3 On the main menu, select Job > Go to running task.

The Converter Standalone manager switches to Task View and preselects the currently running task of the job you selected in Job View. If none of the job’s tasks is running, no selection is made.

Deactivate a Job
You can deactivate an active job without applying any changes to the destination machine.

Prerequisites

Note You can deactivate a job only if none of its tasks is currently running.

Procedure
1 From the View by drop-down menu on the toolbar, select Jobs.
2 From the job list, select the job you want to deactivate.
3 From the main menu, select Job > Deactivate.

The job state changes to inactive and no changes are applied to the destination.

Note An inactive job cannot be reactivated.
Delete a Job

You can delete a job and all its tasks.

**Prerequisites**

You can delete only deactivated jobs.

**Procedure**

1. From the View by drop-down menu on the toolbar, select Jobs.
2. From the job list, select the job you want to delete.
3. From the main menu, select Job > Delete.

The job is removed from the job list, and all the tasks of the job are removed from the task list.

Create a Job by Copying an Existing Job

You can create a new job by creating a copy of an existing job and modifying its settings in the Conversion or the Configuration wizard. The settings for the original job appear at each step of the wizard so that you can reuse or change them.

**NOTE**

You can copy only jobs that were created with the Converter Standalone client.

**Procedure**

1. From the View by drop-down menu on the toolbar, select Jobs.
2. From the job list, select the job you want to copy.
3. Select Job > Copy As New.
4. Follow the prompts to modify the job settings.
5. Click Finish to add the new job to the job list.

Filter the Jobs in the Jobs List

You can select the jobs that you want the job list to display by filtering them.

You can filter jobs by history, status, or multiple criteria.

- **Filter Jobs by History** on page 88
  
  You can filter the list so that it displays only the last submitted jobs. By default, the job list displays the last twenty jobs.

- **Filter Jobs by Status** on page 88
  
  You can filter the job list to display jobs based on their status: Active, Inactive, and All. By default, the job list displays only active jobs. Active jobs include all running, scheduled, and not scheduled jobs.

- **Filter Jobs by Multiple Criteria** on page 88
  
  You can combine filtering criteria to filter jobs in the job list.
Filter Jobs by History

You can filter the list so that it displays only the last submitted jobs. By default, the job list displays the last twenty jobs.

Procedure

1. From the View by drop-down menu on the toolbar, select Jobs.
2. On the main menu, click View > History Filter and select a level of filtering.

Only jobs that correspond to selected filtering level remain in the job list.

Filter Jobs by Status

You can filter the job list to display jobs based on their status: Active, Inactive, and All. By default, the job list displays only active jobs. Active jobs include all running, scheduled, and not scheduled jobs.

Procedure

1. From the View by drop-down menu on the toolbar, select Jobs.
2. On the main menu, select View > Filter by.
3. Select a level of display from the drop-down menu.
   If you are connected to a remote Converter Standalone server, you can select My own to view only jobs that you have created.

Filter Jobs by Multiple Criteria

You can combine filtering criteria to filter jobs in the job list.

Procedure

1. From the View by drop-down menu on the toolbar, select Jobs.
2. Use the drop-down menus in the toolbar to select the status and the history criteria.
   The two filtering conditions combine to show only jobs that comply with both conditions.

Add a Synchronization Task to a Conversion Job

You can add a synchronization task to an active conversion job and modify the synchronization settings in the Conversion wizard.

NOTE You can add synchronization tasks only to jobs that were created with the Converter Standalone client.

Prerequisites

The conversion job must be active and allow synchronization.
No synchronization task that belongs to this job must be running.

Procedure

1. From the View by drop-down menu on the toolbar, select Jobs.
2. From the job list, select the conversion job to which you want to add a synchronization task.
3. From the main menu, select Job > Synchronize.
4. Follow the prompts to modify the synchronization settings.
5. Click Finish to save changes.
Manage Tasks in the Task List

The Task View of the Converter Standalone manager provides a list of all tasks that are submitted. You can use the main application menus to control the way tasks appear in the task list and to edit them.

Prerequisites

You must submit a conversion or configuration job to view its tasks in the task list.

You must be in the Tasks View of the Converter Standalone manager to access the application menus for managing task.

- Control the Number of Tasks Running Concurrently on page 89
  You can set the number of tasks that can run concurrently to improve the conversion speed. Limiting the number of concurrent tasks helps you reduce the network resources required for the conversion tasks. Limiting the number of concurrent tasks also helps to limit the CPU load on the machine where the Converter Standalone server runs.

- View the Job to Which a Task Belongs on page 90
  You can switch from Task View to Job View to view and edit the job to which a selected task belongs.

- Cancel a Task on page 90
  You can cancel a task that is in the queue or in progress.

- Filter the Tasks in the Task List on page 90
  The number of archived tasks can grow to be very large. To minimize clutter in the task list, you can lower the number of tasks that appear. You can select the tasks that you want the task list to display by filtering them.

Control the Number of Tasks Running Concurrently

You can set the number of tasks that can run concurrently to improve the conversion speed. Limiting the number of concurrent tasks helps you reduce the network resources required for the conversion tasks. Limiting the number of concurrent tasks also helps to limit the CPU load on the machine where the Converter Standalone server runs.

You can set the number of concurrent tasks to any number from 1 to 12. The default number of concurrent tasks is set to Maximum.

Procedure

1. On the main menu, select Administration > Maximum Concurrent Tasks.
2. In the Custom spin-box, specify a number.
3. Click OK.

The setting takes effect immediately for all newly added tasks. See “Example: Limiting the Number of Concurrent Tasks,” on page 89.

Example: Limiting the Number of Concurrent Tasks

Assume that Converter Standalone is running 12 tasks. If you change the number of concurrent tasks to 6, these 12 tasks continue running, but all newly added tasks remain pending in the task list.

When the number of running tasks drops to 5, a new task from the wait list starts.
View the Job to Which a Task Belongs

You can switch from Task View to Job View to view and edit the job to which a selected task belongs.

Procedure

1. From the View by drop-down menu on the toolbar, select Tasks.
2. From the task list, select a task.
3. On the main menu, select Task > Go to job.

The Converter Standalone manager switches to Job View. The job that contains the task you selected in Task View is preselected in the list and complies with the current filter of the Job View.

Cancel a Task

You can cancel a task that is in the queue or in progress.

When you cancel a conversion task, the task is removed from the queue. Canceling a configuration task removes it from the queue and reverts the source machine to its original state. Canceling a task that is not a synchronization task deactivates the job to which the task belongs.

Canceling a task in progress does not stop it. You cannot restart a canceled task.

Procedure

1. From the View by drop-down menu on the toolbar, select Tasks.
2. From the task list, select the task you want to cancel.
3. Click Cancel.

The task is now out of the queue and the time of cancellation appears in the End Time column.

Filter the Tasks in the Task List

The number of archived tasks can grow to be very large. To minimize clutter in the task list, you can lower the number of tasks that appear. You can select the tasks that you want the task list to display by filtering them.

You can filter tasks by history, status, or multiple criteria.

- Filter Tasks by History on page 90
  You can use the date on which a task is created to filter the task list.

- Filter Tasks by Status on page 91
  You can change which tasks appear in the task list based on their running status.

- Filter Tasks by Multiple Criteria on page 91
  You can combine filtering criteria to filter tasks in the task list. Tasks that are currently running are displayed regardless of the filtering criteria you apply.

Filter Tasks by History

You can use the date on which a task is created to filter the task list.

This option does not affect tasks in progress. Tasks in progress always appear in the task list.

Procedure

1. From the View by drop-down menu on the toolbar, select Tasks.
2. On the main menu, click View > History Filter and select a level of filtering.
Only tasks that correspond to the selected filtering level remain in the task list.

**Filter Tasks by Status**

You can change which tasks appear in the task list based on their running status.

**Procedure**

1. From the View by drop-down menu on the toolbar, select Tasks.
2. On the main menu, select View > Filter by.
3. Select a level of display from the drop-down menu.
   - If you are connected to a remote Converter Standalone server, you can select My own to view only tasks of jobs that you create.

**Filter Tasks by Multiple Criteria**

You can combine filtering criteria to filter tasks in the task list. Tasks that are currently running are displayed regardless of the filtering criteria you apply.

**Procedure**

1. From the View by drop-down menu on the toolbar, select Tasks.
2. Use the drop-down menus to select the status and history criteria.
   - The two filtering conditions combine to show only tasks that comply with both conditions.

**Verify Jobs and Tasks Progress and the Log Files**

The Task View and Job View of the Converter Standalone manager allows you to observe the progress and the state of the listed jobs and tasks.

If certain problems cause a job or task to fail, you can also review information in the log files.

- **View Task Progress** on page 91
  - The Task view and the Details view show the progress of tasks. You can view the estimated time left to the completion of a conversion task in the End Time column.

- **Export the Log Files for Jobs** on page 92
  - You can review the log files for information about the jobs, or send a copy of log files to VMware technical support. You can export the log files for all jobs in the job list.

- **Export the Log Files for a Task** on page 92
  - If any problems cause a task to fail, you can review information about the task in the log files or send a copy of the log files to VMware technical support. You can export the log files for a specific task in the task list.

- **Back-End and Client Log Files Locations** on page 92
  - Converter Standalone saves log files as it operates.

**View Task Progress**

The Task view and the Details view show the progress of tasks. You can view the estimated time left to the completion of a conversion task in the End Time column.

You can obtain a general indication of a task's progress by looking at its row in the task list of the Task view. You can view the Task progress tab in the Details view for more information.
Procedure
1. From the View by drop-down menu on the toolbar, select Tasks.
2. Select the row in the task list for the task to view.
   The information for that task appears in the Details pane below the tasks list.
3. Click the Task progress tab to view the task status and log highlights.

Export the Log Files for Jobs
You can review the log files for information about the jobs, or send a copy of log files to VMware technical support. You can export the log files for all jobs in the job list.

Procedure
1. From the View by drop-down menu on the toolbar, select Jobs.
2. Select a job in the job list.
3. On the main menu, select Job > Export Logs.
4. Select a location to which you want to save the files and click Save.

The log files for all jobs in the job list are saved to the selected location.

Export the Log Files for a Task
If any problems cause a task to fail, you can review information about the task in the log files or send a copy of the log files to VMware technical support. You can export the log files for a specific task in the task list.

Procedure
1. From the View by drop-down menu on the toolbar, select Tasks.
2. Select the task in the task list.
3. In the Details pane, click the Task Progress tab.
4. Click Export Logs.
5. Select a location to which you want to save the files and click Save.

The log files for this task are saved to the selected location.

Back-End and Client Log Files Locations
Converter Standalone saves log files as it operates.

Table 6-1 lists the default locations where log files are saved. You can view the log files or send them to VMware support, if necessary.

These file locations are also the file locations on the remote machine if you are running a remote hot clone. To send these log files from a remote machine to VMware support, you must manually compress and send them.
<table>
<thead>
<tr>
<th>Log Files</th>
<th>File Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Converter Standalone server and agent log files</td>
<td><code>%ALLUSERSPROFILE%\Application Data\VMware\VMware vCenter Converter Standalone\logs*</code></td>
</tr>
<tr>
<td>Converter Standalone client log files</td>
<td><code>%USERPROFILE%\Local Settings\Application Data\VMware\VMware vCenter Converter Standalone\Logs*</code></td>
</tr>
</tbody>
</table>
Index

A
Acronis True Image, source 23
add a disk 54
adding jobs 86
advanced customization
guest operating system 64
installing VMware Tools 67
removing system restore checkpoints 68
synchronizing source and destination 71
agent 10
allocate memory 61
audience 5

C
changing the number of tasks displayed 90, 91
client 10
cloning
cold, defined 11
disk based 15
disk-based cloning 16
full clones 16
hot, defined 11
linked clones 16
volume based 15
volume-based cloning 16
cloning modes 15
cold cloning
boot CD 15
defined 11
command-line commands 36
components 10
configuration options 79
configuration, submitting job 83
configure the conversion job 69
configure the hardware
allocate memory 61
configure the Helper VM network 63
configure the network settings 62
edit the number of processors 60
edit the number of processors cores 60
edit the number of processors sockets 60
specify a disk controller 62
configure the hardware of the destination machine 51
configure the network settings 62
configure the software 63
configuring
domain details 82
guest operating system 79
install VMware tools 79
removing system restore checkpoints 83
selecting a source 76
selecting VMware Fusion source 76
selecting VMware Player source 76
selecting VMware Server source 76
selecting Workstation source 76
Sysprep files locations 31
Sysprep files locations 75
time zone 81
updating drivers 83
workgroup 82
configuring permissions for vCenter users 27
connect to a remote Converter Standalone server 39
controlling the number of concurrent tasks 89
conversion 88
conversion jobs
submitting 74
viewing summary 74
conversion limitations
configuration limitations 24
Linux guest limitations 24
powered-on machine limitations 24
third-party images limitations 24
third-party virtual machines or system images 25
virtual machines 24
VSS snapshots 32
windows guest limitations 24
conversion tasks
managing 85
maximum running 89
starting 42
conversion throttling 73
conversion wizard, starting 42
conversion, viewing job summary 74
Converter Standalone
installing client in Windows 33
installing in Windows 33
installing server and agent in Windows 33
modifying installation in Windows 37
repairing in Windows 38
converting
existing system images 18
existing virtual machines 18
converting machines 41
converting, powered-on machines 71
copy all disks 59
copy disks or volumes
copy all disks 59
create an expandable disk on a hosted destination 57
create an expandable disk on a managed destination 57
delete a disk 58
move a disk to a different datastore 56
move a volume to a different datastore 54
move a volume to a different virtual disk 54
resize a volume 52
skip a volume 53
create an expandable disk on a hosted destination 57
create an expandable disk on a managed destination 57
customization 31
customize the location 49
customizing
computing resources 73
tasks throttling 73
customizing the guest operating system 64

data to copy 51, 59
delete a disk 58
delete job 87
destination
ESX host 25
vCenter Server 25
VirtualCenter 25
VMware Fusion 25
VMware Player 25
VMware Server 25
Workstation 25
destination machine
folder 48
naming 48
power on 72
destination services, startup mode 69
destination setup
computer information 64
DNS 66
domain details 67
guest operating system 64

network adapters 66
SID 64
time zone 66
Windows license 65
WINS 66
workgroup 67
disk
2GB split 17
not pre-allocated 17, 57
thick 17
thin-provisioned 17, 57
disk cloning modes
disk-based cloning, defined 16
full clones, defined 16
linked clones, defined 16
volume-based cloning, defined 16
disk controller 62
disk-based cloning 15, 16, 56, 57, 59
disks, adding 55
dual boot systems 11
duplicate ID 18

edit the number of processors 60
errors, viewing in the log files 92
ESX host
destination 25
source 23
support 23
ESX VM, source 44
exporting
to hosted formats 48, 50
to managed formats 48
exporting a single task log file 92
exporting jobs logs 92

feedback 5
filtering jobs 88
filtering jobs by history 88
full clones, defined 16

glossary 5
go to job 90
go to running task 86
guest operating system configuration
computer information 80
DNS 82
domain 82
network adapters 82
SID 80
powered-on machine conversion limitations 24
powered-on machine, source 43, 44
progress viewing 91

R
reconfiguring, starting the Wizard 76
remote Converter Standalone server 39
repairing 37

S
screen resolution requirements 23
selecting configuration sources
VMware Desktop VMs 78
VMware Infrastructure VMs 77
selecting sources
ESX virtual machine 44
hosted virtual machine 46
Hyper-V Server VM 47
Linux powered-on machine 44
powered-on machine 43
third-party VM 46
vCenter Server VM 44
Windows powered-on machine 43
server 10
services
on destination 69
on source 70
setting up destination
computer information 64
DNS 66
domain details 67
guest operating system 64
network adapters 66
SID 64
time zone 66
Windows license 65
WINS 66
workgroup 67
setting up SID 80
Simple File Sharing, turning off 31
skip a volume 53
snapshots, limitations 32
source machine
power off 72
uninstall Converter Standalone agent 73
source services, stop 70
specify a disk controller 62
starting
conversion 42
conversion wizard 42
starting the reconfiguration wizard 76
stop source services 70
StorageCraft ShadowProtect, source 23
support 5
supported destination types
ESX host 25
vCenter Server 25
virtual appliances 25
VirtualCenter 25
VMware Fusion 25
VMware Player 25
VMware Server 25
Workstation 25
supported operating systems 21
supported source types
Acronis True Image 23
ESX support 23
Hyper-V 23
Microsoft Virtual PC support 23
Microsoft Virtual Server support 23
Parallels Desktop 23
powered-on machines 23
StorageCraft ShadowProtect 23
Symantec LiveState Recovery 23
vCenter Server 23
Virtual Iron 23
VirtualCenter support 23
VMware Fusion support 23
VMware Server support 23
VMware virtual machines 23
Workstation support 23
Xen 23
switch to jobs view 86, 90
Symantec LiveState Recovery, source 23
synchronize conversion 88
synchronizing source with destination 71
sysprep 31
system images, converting existing 18
system reconfiguration 10
system requirements
installation space requirements 22
supported operating systems 21
TCP/IP and UDP port requirements 28
Windows operating systems 30
T
task manager
canceling tasks 90
combined filtering 91
filtering by multiple criteria 91
filtering tasks by history 90
filtering tasks by status 91
number of concurrent tasks 89
viewing task progress 91
tasks, filtering 90
tasks, managing 89
tasks, submitting configuration 83
TCP/IP and UDP port requirements 28
thin-provisioned destination disks 9
thin-provisioned disk 57
third-party VM, source 46
throttling conversion tasks 73
time zone configuration 81

U
uninstall Converter Standalone agent 73
uninstalling 33
uninstalling VMware vCenter Converter Standalone, in Windows 39
updated information 7

V
VCB, See VMware Consolidated Backup
vCenter Converter
migration with tasks 9
vCenter permissions 27
vCenter Server, destination 25
vCenter Server support 23
vCenter Server virtual machines 45
vCenter Server VM, source 44
version support 23
viewing a task's progress 91
viewing conversion job summary 74
viewing the log files 92
virtual disk 54
virtual disk, adding 55
virtual hardware
CPU issues 19
disk device issues 19
Ethernet adapter issues 19
graphics card issues 19
Virtual Iron, source 23
virtual machines
conversion limitations 24
converting existing 18
destination on same network as source 18
VirtualCenter
destination 25
source 23
support 23
VMware Consolidated Backup 26
VMware Fusion
destination 25
source 23
support 23
VMware hosted products, information not preserved when using Converter Standalone 27
VMware hosted products support 23
VMware managed products, information not preserved when using Converter Standalone 26
VMware managed products support 23
VMware Player
destination 25
source 23
support 23
VMware Server
destination 25
source 23
support 23
VMware Tools 67
VMware vCenter Converter Boot CD 10
VMware vCenter Converter Standalone command-line installation in Windows 36
installing remote access in Windows 34
uninstalling in Windows 39
volume cluster size 53
volume-based cloning 15, 52–54, 57, 58
volume-based cloning, defined 16
volume, supported types 15, 16
volumes, excluding 53
volumes, moving 55
volumes, resizing 52
VSS snapshots limitations 32

W
Windows, Simple File Sharing 31
Windows virtual machines, configuring 75
Windows XP, turning off Simple File Sharing 31
Windows XP, checking Windows Firewall blocks 30
worker 10
Workstation
destination 25
source 23
support 23

X
Xen, source 23